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» 'These slides
http://sci2.cns.iu.edu/docs/2011-borner-SciTS-workshop.pdf

» Sci2 Tool Manual v0.5 Alpha
http://sci2.wiki.cns.iu.edu W
> Sci2 Tool v0.5 Alpha (April 4, 2011) % @

http://sci2.cns.iu.edu

b'
NWS Tool f’ |

Bl Sci’ Tool

Sci® Tool 0.5 clpha |
Seif Manual is af:

» Additional Datasets
http://sci2.wiki.cns.iu.edu/2.5+Sample+Datasets

> Additional Plugins

MNWE Tool v1.0
NWE Tuborial

Cybarinfrastructurs lor Nabwark Stence Canter, Indiona Univenity

http://sci2.wiki.cns.iu.edu/3.2+ Additional+Plugins w - °

Or copy them from the DVD or memory stick.




° x Workshop Overview

1:15 Macroscope Design and Usage & CIShell Powered Tools: NWB &
Sci2

1:45 Sci2 Tool Basics

» Download and run the tool.

2:00 Sci2 Sample Workflow: Padgett's Florentine Families - Prepare, load,
analyze, and visualize family and business networks from 15th century
Florence.

2:30 Sci2 Sample Workflow: Studying Four Major NetSci Researchers.

» Load and clean a dataset as text file; process raw data into networks.
» Find basic statistics and run various algorithms over the network.

» Visualize as either a circular hierarchy or network

3:30 Break

4:00 Sci2 Demo I: Geospatial maps with congressional districts

4:30 Sci2 Demo II: Evolving collaboration networks

4:45 Outlook and Discussion

5:00 Adjourn
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Different datasets/formats.
Diverse algorithms/tools written in
many programming languages.

The Changing Scientific Landscape

Star Scientist -> Research Teams: In former times, science was driven by key scientists.
Today, science is driven by effectively collaborating co-author teams often comprising
expertise from multiple disciplines and several geospatial locations (Borner, Dall'Asta,
Ke, & Vespignani, 2005: Shaeidarman 2008)

Users -> Contributors: \ .
Wikipedia or to excha  Cyberinfrastructure and Datasets |,
WikiProfessionals, or port
of real time communit| for SciTS Research

Cross-disciplinary: The |
methods and techniqu
interdisciplinary and/q tors

to fine-tune and interp WedneSday, Apfﬂ 13 « 12:00 PM - 1:15 PM

One Specimen -> Data bacarmororoeroocopeoamavercocopoo—wereorgrrramy—oooat O
study one specimen at a time. Today, many researchers must make sense of massive
streams of multiple types of data with different formats, dynamics, and origin.

Static Instrument -> Evolving Cyberinfrastructure (CI): The importance of hardware
instruments that are rather static and expensive decreases relative to software
infrastructures that are highly flexible and continuously evolving according to the
needs of different sciences. Some of the most successtul services and tools are
decentralized increasing scalability and fault tolerance.
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Custom Tools for Different Scientific Communities

6 ¢ = Information Visualization Cyberinfrastructure
- . .
Eﬁ http://iv.cns.iu.edu
_'5 | RS ' Network Workbench Tool + Community Wiki

s http://nwb.cns.iu.edu

Science of Science (Sci?) Tool and Portal

. http://sci2.cns.iu.edu
181 Wi Hoidem: )
s AR pidemics Cyberinfrastructure

Coming soon

180+ Algorithm Plugins and Branded GUlIs
+

Core Architecture

Open Services Gateway Initiative (OSGi) Framework.

http://orgi.org
Cyberinfrastructure Shell (CIShell)

http://cishell.org
- =
== [=(e)
0SGi (@

Alliance

CIShell Powered Tools:
Network Workbench (NWB)




Downloads for NWB Tool Releases
Network Workbench Tool )
.o . 50,000
http://nwb.slis.indiana.edu
Curmulative Total of Downloads [~
89,559
40,000
The Network Workbench (NWB) tool
30,000
supports researchers, educators, and
practitioners interested in the study of i —
iomedical ial an; havior: ien
bio .ed cal, social and behavioral science, m eople Research Publicaion: |8
physics, and other networks.
1 Summary
In February 2009, the tool provides more 169 | summary e setwor s
. M Toolkit for Biomedical, Social Science and F
Plugms thélt Support the preproceSSIng evaluate, and operate a unigue distributed,
. . . . . scale network analysis, modeling, and visual
analysls, modehng, and visualization of (MWE). The envisioned ata-code-computi avy.
more ~/
networks. How to cite this project oA
Dec-oé Dec-o7 Dec-08 Dec-og  Augto
More than 50 of these plugins can be NEHSEUBHates W03 W 07+ post
. . . = 5.1.09 Kaelhle, Steve. 2009. Mapping the F o o
applied or were specifically designed for iioefeue. Réseareh & Cresive Acthl 3 v0.4 W 08+ pre
. website accessed 51/09) . 0.5 . 0.9
S&T Studles' * 3.23.091.0.0 beta 5 Released e L
o B o6 B v1.00+ pre
= 1.23.09 Ann hicranie's futorial abstract for 5|
053 Total # of Downloads
It has been downloaded more than 65,000 + 11.4.08 Two NWE Pis featured in "Connected—The _Getting Start=n
> Power of Six Degrees.” 2008. Anna Maria Talas, See more documentation
: H Director. Australian Broadcasting Corporation, Ltd. T
times since December 2006. s o

Herr 11, Bruce W., Huang, Weixia (Bonnie), Penumarthy, Shashikant &> Birner, Katy. (2007). Designing Highly Flexible and Usable
Cyberinfrastructures for Convergence. In Bainbridge, William S. & Roco, Mihail C. (Eds.), Progress in Convergence - Technologies for Human
Wellbeing (Vol. 1093, pp. 161-179), Annals of the New York Academy of Sciences, Boston, MA.

Investigators:

Software Team:

Goal:

Amount:
Duration:

Website:

Katy Borner, Albert-Laszlo Barabasi, Santiago Schnell,
Alessandro Vespignani & Stanley Wasserman, Eric Wernert

Lead: Micah Linnemeier

Members: Patrick Phillips, Russell Duhon, Tim Kelley & Ann McCranie

Previous Developers: Weixia (Bonnie) Huang, Bruce Herr, Heng Zhang,
Duygu Balcan, Bryan Hook, Ben Markines, Santo Fortunato, Felix
‘erkhorn, Ramya Sabbineni, Vivek S. Thakre & Cesar Hidalg

Develop a large-scale network analysis, modeling and visualization toolkit
for physics, biomedical, and social science research.

$1,120,926, NSF 11S-0513650 award
Sept. 2005 - Aug. 2009
http:

nwb.slis.indiana.edu
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m Project Details (cont.)

NWB Advisory Board:

James Hendler (Semantic Web) http://www.cs.umd.edu/~hendler

Jason Leigh (CI) http://www.evl.uic.edu/spiff

Neo Martinez (Biology) http://online.sfsu.edu/~webhead

Michael Macy, Cornell University (Sociology) http:/ /www.soc.cornell.edu/faculty/macy.shtml

Ulrik Brandes (Graph Theory) http://www.inf.uni-konstanz.de/~brandes

Mark Gerstein, Yale University (Bioinformatics) http://bioinfo.mbb.vale.edu
Stephen North (AT&T) http://public.research.att.com/viewPage.cfmrPagelD=81

Tom Snijders, University of Groningen http://stat.camma.rug.nl/snijders

Noshir Contractor, Northwestern University http://www.spcomm.uiuc.edu/nosh
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Computational Proteomics
What relationships exist between protein targets of all drugs and all
disease-gene products in the human protein—protein interaction network?
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Figure 2 Drug-target network (DT network). The DT network is generated by using the known associations between FDA-approved drugs and their target
proteins. Circles and rectangles correspond to drugs and target proteins, respectively. A link is placed between a drug node and a target node if the protein

is a known target of that drug. The area of the drug (protein) node is proportional to the number of targets that the drug has (the number of drugs targeting
the protein). Color codes are given in the legend. Drug nodes (circles) are colored according to their Anatomical Therapeutic Chemical Classification, and the
target proteins (rectangular boxes) are colored according to their cellular compeonent obtained from the Gene Ontology database.
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Computational Economics

Does the type of product that a
country exports matter for
subsequent economic performance?

vegetables

2

coffee and cocoa
products

C. A. Hidalgo, B. Kiinger,
A.-L. Barabas:, R. Hausmann
(2007) The Product Space
Conditions the Development

of Nations. Science 317,

482 (2007).
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Fig. L. The product space. (A) Hierarchically clustered proximity (¢) matrix
representing the 775 SITC-4 product classes exported in the 1998—2000
period. (B) Network representation of the product space. Links are color coded

with their proximity value. The sizes of the nodes are proportional to world
trade, and their colors are chosen according to the classification introduced by
Leamer.
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Computational Social Science
Studying large scale social
networks such as Wikipedia

Second Sight: An Emergent Mosaic of
Wikipedian Activity,
The NewScientist, May 19, 2007

¢ Conference on Network Science
1 in Bleomingten.

Second sight
O
Imane: Bruce W. Herr and Tadd M. Holloway

Power struggle

How do you keep track of the bubbling
mass of information that is Wikipedia?
This chaotic-leoking mosaic is one
atlempt o show which topics are

B

i l-=

ik
B

Twam
iR

pages at the time of writing incdude
entries on Sheffield Wednesday football
club, Mikhail Gorbachew and pigs).

The masaic has been commended in
a competition for images that visualise
network dynamics, coinciding with this
week’s International Workshop and

v it com 19 Moy 200 | ewscortist| 55




Computational Epidemics
Forecasting (and preventing the effects of) the next pandemic.

Epidemic Modeling in Complex realities, V. Colizza, A. Barrat, M. Barthelenzy, A.1 espignani, Comptes Rendus
Biologie, 330, 364-374 (2007).

Reaction-diffusion processes and metapopulation models in heterogeneous networks, 1.Colizza, R. Pastor-Satorras,
A.Vespignani, Nature Physics 3, 276-282 (2007).

Modeling the Worldwide Spread —-Impuc?“
of Pandemic Influenza: Baseline 3

—

or Air Travel on Global Spread or Infectious Diseasess—

Case and Containment Interventions,

V. Colizza, A. Barrat, M. Barthelenzy,
A.-J. Valleron, A.V espignani,
PloS-Medicine 4, 13, 95-110 (2007).

—— = S
= )
. =
* Forecasts or 1HE Next Pandemic Influenza ®
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NWB Tool 1.0.0 -| '|\'||L'||l.' . I|]\'|il|l|l||l.'r||l:| f!u-l:!r ST ﬂl‘lh‘h’lmm = p‘ |
Fle Edt Vew Favorkes Took  Help
Can be freely downloaded for all SR Bt o e
. . g nakirs bbb | D1 % i T . - Tgokse e
major operating systems from Do l—— = e

http://nwb.cns.iu.edu

Select your operating system from
the pull down menu and download.

Unpack into a /nwb directory.

Run /ﬁWb/ﬂWbCXC Dowritad o WD To Bt

Tool 1.0.0 Official Release
September 1580 2009

Release Notes

Session log files are stored in
“Syournwbdirectory*/ logs’ directory.

Windows (P & Vissa) ~ | [,
fviindows [ & vista) |

Cite as o I

NIWB Team. (2006). Network S % |

Workbench Tool. Indiana University, e :

Northeastern University, and University of (Vi 07 8 Vi )

Michigan, http:/ [ nwb.cns.in.edn. = .
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Network Workbench Tool

File Preprocessing Modeling  Analysis  Visualization  Scientometrics  Help

£l consale Console displays data operations =0 D.ata Manager =0
Iwelcome bo the Metw |:5°Vef |ou<_i, view, efc ) and reprocessing, modeling, analysis, and ~ |
visualization of small, ulgor!lhm input parameters, =

selection, & acknowledgements as
The Metwork Workbeni well as error reporting. 5 supporked in part by the MSF Data Manager keeps frack of
115-0513650 award, Th f, Dr. Albert-Laszld Barabasi, Dr. Santiago all datasets that are available

Schnell, Dr. Alessandro Yespignani, Dr. Stanley Wasserman, and Dr. Eric A, Wernert, for algorithmic visualization

The MWE kool was developed by Weixia Huang, Russell Duhon, Micah Linnemeier, Timothy Kelley, Duygu X or manipulation. J|

Balcan, Mariano Beird, Bruce Herr, Santo Fortunato, Ben Markines, Felix Terkhorn, Heng Zhang, Megha
Ramawat, César Hidalgo, Ramya Sabbineni, Yivek Thakres, Soma Sanyal, Ann McCranie, Alessandro
‘espignani, and Katy Borner, It uses the Cyberinfrastructure Shell (http:/ /cishell.org) developed at the
Cyberinfrastructure For Metwark Science Center (hitp://cns.slis.indiana.edu) at Indiana University.

Please cite as Follows:
MWE Team, (2006}, Metwork Workbench Tool, Indiana University and Mortheastern University, —

(http:/ /nwhb.slis.indiana.edu oy -
L 7 . . = = Table
Bl Scheduler Scheduler lists what algorithms you've =5 )
used and displays algorithm L Matrix-
rogress. I

i Text

G GuEss

| I Algorithm Mame Date Time % Complete | '\?
| Tree
[

@« Network-

Console shows references to seminal works.
Workflows are recorded into a log file, and soon can be re-run for easy replication.
All algorithms are documented online; workflows are given in tutorials.

File, Preprocessing, Modeling, and Visualization Menus

File Preprocessing Modeling Wisualization

Load... Extract Top Modes Random Graph GUESS
Load and Clean ISI File Extract Modes Above ar Belaw Yalue Watts-Strogatz Small warld SnuFlot
Read Directory Hierarchy Remove Mode Attributes Barabasi-albert Scale-Free
Datasets Delete High Degree Modes - DrL {4xOrd)

Delete Random Nodes Specified (prefuse beta)
Save... Chord

Delete Isolates X X

Hypergrid Circular {JUNG)

Wigw. ..

Extract Top Edges FRU

i i Radial TreefGraph f Iph
W o Extract Edges Above or Below Value @ !a A (Fre use alp .a)
; TARL Radial Tree/Graph with Annatation (prefuse beta)

Merge Node and Edge Files Remove Edge Attributes Tree Map (prefuse beta)
Split Graph to Node and Edge Files|  Remave Self Loops Discrete Metwark Dynamics (DRHDY

K Tree Yiew (prefuse beta)
Trim by Degree X X
Tests Evolving Metwork (Weighted) Ballaon Graph (prefuse alpha)

Snowball Sampling {n nodes)

Preferences Node Sampling Force Directec! with Annotation (prefuse beta)
" Kamada-Kawai {JUNG)
Eudt B Sy Fruchterman-Reingold {JUMNE)
Symmetrize Fruchterman-Reingold with Annotation {prefuse beta)
Dichotomize Spring {IJMG)
Multipartite Joining Small World {prefuse alpha)

Iormalize Text

Farallel Coordinates (d
Slice Tiable by Time arallz] Coardineitzs (domo)

Lahlet

Circular Hierarchy

Bérner, Katy, Sanyal, Soma and Vespignani, Alessandro (2007). Network Science. In Blaise Cronin (Ed.),
ARIST, Information Today, Inc./American Society for Information Science and Technology, Medford, NJ,
Volume 41, Chapter 12, pp. 537-607.

http://ivl.slis.indiana.edu/km/pub/2007-borner-arist.pdf




AEhisiNaihengie Analysis Menu and Submenus

Analysis Uriweighted and Undirected > | Urweighted and Directed > |
Network Analysis Toolkit (NAT) bl x:’ g“fg“
Linweighter and Undirected Degree Distribution e Oul _gr_ee
) _ » Indegree Distribution
‘Weighted and Undirected Watts-Strogatz Clustering Coefficient Outdegree Distribution
Unweighted and Directed Watts Strogatz Clustering Coefficient over K
‘Weighted and Directed K-Nearest Neighbor
I Single Node In-Out Degree Cotrelations
Search Average Shortest Path
Discrete Network Dynamics Shortest Path Distribution PageRank
Textual Mode Betweenness Centrality HITS
Global Connected Components e
‘Weighted and Undirected » | HITS Arc Reciprocity
) officient Adjacency Transitivity
Clustering Coeffici wWeak Component Clustering
Nearest Neighbor Degree Blondel Community Detection weak Component Clustering
Strength vs Degree ; Strong Component Clustering
Degree & Strength MST-Pathfinder Metwork SCJI'IQ
Average Weight vs End-point Degres O Blondel Community Detection
K-Nearest Neighbor (Java) Annotate K-Coreness Extract K-Core
Strength Distribution Annotate K-Coreness
Weight Distribution Weighted and Directed » |_
Randomize Weights HITS Search | Text C
MST-Pathfinder Network Scaling Wolghted PageRark Can Burst Detection
Fast Pathfinder Network Scaling Fast Pathfinder Network Scaling Chord
K Random-Walk Discrete Network Dynamics 3
Blondel Community Detection EBlondel Community Detection Random Breadth First Extract and fnnotate Attractors

Borner, Katy, Sanyal, Soma and Vespignani, Alessandro (2007). Network Science. In Blaise Cronin (Ed.),
ARIST, Information Today, Inc./American Society for Information Science and Technology, Medford, NJ,
2007-borner-atist.

Volume 41, Chapter 12, pp. 537-607. http:

ivl.slis.indiana.edu/km

ub

df
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CIShell — Customize Menu

» 'The file Yourtooldirectory/ configuration/ defanlt_menn.xm!’ encodes the structure of

the menu system.

» In NWB Tool, the Modeling menu (left) is encoded by the following piece of

xml code:

& Netwark Warkbench Taal

File Preprocessing [Modeling | Analysis Visualization Scientometrics

B Console Random Graph
INE NETWOTK WorkDe
investigators are Or,
Wasserman, and Dr.
Can

Chord

The NWE tool was d
Tank, Joseph Bibersti
Tetkhorn,Heng Zhan N
Wespignani, and Katy, vperg

PRU
Metwork Workbench
Science Center http:  TARL
Please cite as follous
W Tearn, (2006).

http:inwb.slis.indiar

Watts-Strogatz Small World
Barabasi-flbert Scale-Free

Discrete Netwark Dynamics (DI

Evolving Netwark (Weighted)

=a
chi

uce
&n

ol d
<top_menu name="Modeling">
<menu pid=" iu. nwh.modeling. erdosrandomgraph” />
<menu ju. nwh.modeling. smallworld" />
<menu iu, nwh.modeling. barabasialbert" />
<menu e
<menu iu. dv.modeling. p2p. can.Canalgorithm” />
<menu iu. dv.modeling. p2p. chord. chordalgorithm" />
<menu id. dv.modeling. p2p. hypergrid. Hypergrid" />
<mernu . dv.modeling. p2p. pru. Prualgorithm" >
<menu "
<menu Jwv.modeling. tarl. Tarlalgorithm" />
<menu "
<mernu iu. nwh. modeling. discretenetworkdynamics. oupalgorithm" />
<menu types= A
<menu pid="edu. ju. nwh.modeling. weighted. evolvingnetwork" />
</ Top_menu>
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0.5 :
resionSE0NSIaticExecutableRunner-S509T0ALGORMHM - egree_distrbution. dat - *
045

n1s
(18}

nos :

-

0
192132, 520101

50 100 150 00 250

Gnuplot

portable command-line driven
interactive data and function plotting

utility http://www.gnuplot.info/.

GUESS

exploratory data analysis and visualization tool
for graphs and networks.

https://nwb.slis.indiana.edu/community/?n=Vi
sualizeData. GUESS.
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Supported Data Formats

The NWB tool supports loading the following input file formats:

GraphML (*.xml or *.graphml)
XGMML (*.xml)

Pajek NET (*.net) & Pajek .Matrix (*.mat)
NWB (*.awb)
TreeML (*.xml)
Edge list (*.edge)
CSV (*.csv)

IST (*.isi)

Scopus (*.scopus)
NSF (*.nsf)
Bibtex (*.bib)
Endnote (*.enw)
and the following network file output formats:
GraphML (*.xml or *.graphml)
Pajek .MAT (*.mat)

Pajek NET (*.net)

NWB (*.nwb)

XGMML (*.xml)

CSV (*.csv)

Formats are documented at https:

e text/tree ml+xml

VVVVYVYVVYVYVYVYYVYYVY

VVVYVYYVYYVYYVY

L cdu.berkeley.quirprefus egraphTr

@ .ciicsjunggraphGraph ®
® ;e.dataTlEE/ ® /

. prefuse.data.Graph

fileitexthgmml +xml

. file text/isi

edu.berke ley.guirprefuse.graph Graph
EI

@ vicons

refusedataTable

file:text/bibtex

. file:text/referbib

. file:text/cov

@ fileitext/graphml +xm|

@ filetext/ps

o

iwt.mageBuffeadlnage

e filetext/jpg

| 1, T
] filetext/edge

. file:application/pajeknet

] file:application/pajekmat

nwb.slis.indiana.edu/community/?n=DataFormats.HomePage.
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CIShell Powered Tools:

Science of Science (Sci2) Tool

Science of Science (Sci2) Tool
http://sci2.cns.iu.edu

» Explicitly designed for SoS research and practice, well documented, easy to use.

» Empowers many to run common studies while making it easy for expotts to
perform novel research.

» Advanced algorithms, effective visualizations, and many (standard) workflows.
> Supports micro-level documentation and replication of studies.

» Is open source—anybody can review and extend the code, or use it for
commercial purposes.

SUMMARY
e Existing metrics have known flaws
e A reliable, open, joined-up data
infrastructure is needed
e Data should be collected on the full
O P | N | O N range of scientists’ work
e Social scientists and economists
should beinvolved

nature Vol 464|25 March 2010

L et's make science metrics more scientific

To capture the essence of good science, stakeholders must combine forces to create an open, sound and

consistent system for measuring all the activities that make up academic productivity, says Julia Lane. 3




Sci? Tool = “Open Code for S&T Assessment”

Joint Co-Authorship Network

OSGi/CIShell powered tool with NWB plugins and

many new scientometrics and visualizations plugins.
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& Blology i [F ] i
& Hirchewabogy
o it Pomesrets . .
:':I‘hryn.:al. ““' hanical. & Civil Engineering SCI Maps GUESS Network VlS

Horizontal Time Graphs

Bérner, Katy, Huang, Weixia (Bonnie), Linnemeier, Micah, Dubon, Russell Jackson, Phillips, Patrick, Ma, Nianli, Zoss,
Angela, Guno, Hanning & Price, Mark. (2009). Rete-Netzwerk-Red: Analyzing and 1 isualizing Scholarly Networks
Using the Scholarly Database and the Network Workbench Tool. Proceedings of ISST 2009: 12th International Conference
on Scientometrics and Informetrics, Rio de Janeiro, Brazil, July 14-17 . 170l 2, pp. 619-630.
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Sci? Tool

seiifarch & practice

A% Sci® Taal
File Preprocessing Modeling  Analysis | Visualization | Scientometrics  Help
B consale. GUESS

Welcome to the Science of Science Toal (Sci GnuPlot .

\The development of this tool is supported i

\Netwnrk Sc?ence center and the Scphpnnl af Li Radial Tree/Graph (prefuse alpha) # Geo Maps "
Indiana University, the Mational Science Fou Radial Tree/Graph with Snnotation (prefuse beta) ﬁ v DS L
and 05-0715303, and the lames 5 McDonnel N y /
Cyberinfrastructure portal thittpaifsci.slis.ind LR ) = = = it
] Tree Map (prefuse beta) el Rata

‘The primary investigatars are Katy Bérner, In e : P

SciTech Strategies Inc, The Sci® tool was dew

). Duhan, Patrick &, Phillips, Chintan Tank, a Fruchterman-Reingaold with Annotation (prefuse beta)
| Cyberinfrastructure Shell thttp:{fcishell.org
(for Metwark Science Center thttp:ficns.slis.i DL (ueOrd)
Mary algarithrm plugins were derived frorm 4
thttp:finwb.slis.indiana.edu).

Force Directed with Annotation (prefuse beta) H

Specified (prefuse beta)

Please cite as follows: orizgataine Sieph

Seif Team, (2009, Science of Science Toaol, T Circular Hierarchy
Strategies Inc., httpaffscislis.indiana.edu.
.......... Geo Map (circle annotations)

B Scheduler| Geo Map (region coloring annotations)

[] Rermowve carmpleted Hriaqmiciier
Reftdapper

! Algorithm Mame Date Tirne % Corr

[ Extract Co-Author Metw.., 0970372004 00:15:20 AN | —
-—
|

Load and Clean ISIFile 08,/03/2009 00:15:05 &M

4 | 1

4 1




Workshop Overview

1:15 Macroscope Design and Usage & CIShell Powered Tools: NWB & Sci2
1:45 Sci2 Tool Basics
» Download and run the tool.

2:00 Sci2 Sample Workflow: Padgett's Florentine Families - Prepare, load,
analyze, and visualize family and business networks from 15th century
Florence.

2:30 Sci2 Sample Workflow: Studying Four Major NetSci Researchers.

» Load and clean a dataset as text file; process raw data into networks.
> Find basic statistics and run various algorithms over the network.

»  Visualize as either a circular hierarchy or network

3:30 Break

4:00 Sci2 Demo I: Geospatial maps with congressional districts

4:30 Sci2 Demo II: Evolving collaboration networks

4:45 Outlook and Discussion

5:00 Adjourn
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Sci? Tool: Download, Install, and Run

Sci2 Tool v0.5 Alpha (April 4, 2011) T T
Can be freely downloaded for all major e IR D T T
operating systems from i e BuRNCIS e A0

http://sci2.cns.iu.edu

a..,.:.- T Atool for science of science research & practice
Select your operating system from the et
Pt

pull down menu and download.

Unpack into a /sci2 directory. —
Run /sci2/sci2.exe e
Sci2 Manual is at B e e e Tt e, S et

http://sci2.wiki.cns.iu.edu

arial. Isbernaticnal Confrorase cu Sovial Competing. Bebnicesl Modelag a0

“The Trastees o Sadiana Usiversicy. SLIS vessarcher promsies innrvatien Dashbsard for palicmaloers during Cagloed Hill viis (xebaioe
20

. Flease clre as
Clte as Scf' Faam £2003). Sckence of Schence 57 Food dndbana Uiwverssy ard Seifoch Srcsegies, b #ack it indisns, ol

Se# Team. (2009). Science of Science (Sci’) Tool.

Indiana University and SciTech Strategies,
hittp:/ [ sci2.cns.in.edu =

Seimmen Crmtes and the Seboe] of Libwiry imd Information Seimmer ot Indiasy
430, i Direnl] Fruestatice.

el
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“i¢e=nl  Sci? Tool: Download, Install, and Run

(N
i

Sci2 Tool v0.5 Alpha (April 4, 2011)
Supports ASCII UTT-8 characters
Web-based Yahoo! and desktop Geocoders
U.S. and World geomapper

Customizable stop word lists i i
) sci2-N-1.0.0.201008130505NGT-macosx.carbon.ppc.zip

; 5¢i2-N-1.0.0.201008130505MNGT-macosccarbonxdb.zip
) 5€i2-N-1.0.0.201008130505MNGT-macosx.cocoaxBb_6d.zip
) s¢i2-N-1.0.0.201008130505NGT-win32.win32x86.zip

Merging of networks
New home page, wiki-based tutorial

YV VYVYYVY

Bug fixes, streamlined workflows

Sci2 Tool runs on Windows, Mac, and Linux.

UnZlP- L1 sciz-N-1, e _ 31,374 KB
. Browse with Corel Paint Shop Pro Photo X2
Run /sci2/sci2 e
un /Sci SClz.exe Open Cornmand Prompt Here
Extract &ll...
Scan for Viruses..,
7-Zip 3 Open archive
Open With.., Extract files...
O Magicls0 N Extract Here
29
Sci2 Tool Interface Components
See also bttp:/ [ sci2.wiki.cns.an.edu/ 2.2+ User+Interface
U % ci2 Tool = S =
NS File DataPreparation Preprocessing  Analysis  Modeling  Wisualization  Help
B Console| = OB Data anager| = O

“Welcome to the Science of Science Tool (Sci®).

» Menu to read data, run
The developrent of this tool is supported in part by the Cyberinfrastructurs for

algorlthms. Netwark Science center and the School of Library and Information Science atIndiana
University, the Mational Science Foundation under Grant Mo, SBE-0738111 and

| »

Y Directory Tree - Prefi

[O5-0715303, and the James 5 McDonnell Foundation, See Science of Science

Cyberinfrastructure portal thttp:ffscislis.indiana.edu) for more information,
onsole to see wor 0og, 4 . P
. Prirnary irvestigators are Katy Bérner, Indiana University and Kewin W, Boyack, SciTech
references to seminal works. Strategies Inc, The Sci’ tool was developed by Micah W, Linnemeier, Russell |, Duhon,
Patrick &, Phillips, Chintan Tank, and Joseph Biberstine, It uses the Cyberinfrastructure  _
LT P O S AT S Y A Y S
» Data Managert to select, view, | |8 sneue] =
5 Rermave Fram List | [] Remove completed automatically | Remave all completed
save loadeq, simulated, or

derived datasets.

! Algorithm Name Date Time % Compl

> Scheduler to see status Of ¥ Read Directory Hierarchy  08/15/2010 (7017 P | —

. . < M | »
algorithm execution. = '

All wotkflows are recorded into a log file (see /sci2/logs/...), and soon can be re-
run for easy replication. If errors occur, they are saved in a error log to ease bug
reporting.

All algorithms are documented online; workflows are given in tutorials, see Sci2
Manual at http://sci2.wiki.cns.iu.edu
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i napn Sci2 Tool — Read+Visualize Sci2 Tool Directory Tree

Use File > Read Directory Hierarchy’ with parameters

Foot direckory I CiDocuments and Settingsikatyt Deskbopimab

Lewels o recurse | 1
V¥ Recurse the entire tree

[ Read directories only {skips files)

a
-~
Cancel |

x|

3
3

£

3

Visualize resulting ‘Directory Tree - Prefuse (Beta) Graph’ using

Visnalization > Tree View (prefuse beta)’
Viisnalization > Tree Map (prefuse beta)’

Visualization > Balloon Graph (prefuse alpha)’
Visualization > Radial Tree/ Graph (prefuse alpha)’

31

Bootoonree SR

Different views of the
/nwb directory
hierarchy.

Note the size of the

workspace
. . ey
/plugin directory. '

Uninztaller

e
sampledata
'

2 Radiia] Tree/Graph (prefuse alpha) (I " o] B o]

edu iy nwb gui brand_1.0.0 (META-INF

:
META-INF
S PR (TTEEE) (e )

23200 22 o)
el 22 e o)

" = =]

FreeHEP VectorGraphics 1.0.0
plefuse lib_20060715.0.0 -DSGMNF

w19, eclipss.equinox.app

a1g.eclipsz.osgi
1g.eslipse update

020070523
METATHF

GUESS org.c\she\llemp\ales.Jy‘thomur\ner

(plugins) WA ME T A INF
Totusd ll} S (T PRILPRCT) s
- SEee]
HWE Filss \ (=100
ioilised Fajek NET Files \ eduuciiczjung_1.7.4 N METAINF
TETRT] (XML Fn org cishell envitonment equinox feature
Fajek MAT Files)Conveter tedt files (e amurae U b J3vaalaorthm feature
Hoitied TreehL ru' £ duiu.nib.convererizature_1.0.0
e
GraphML Files arg_cishell feature_1.00
TSV Files sampledata oig sishellreference. gui feature
Configuration Files edu iu_wb_gui brand feature_1.00
Edge Files org cishellrafarence feature_1.00
binlogy.
piaiec)
GND
.m

(i) (reapusnanel
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Sci2 Tool — Visualize Workshop Attendees

Use File > Read’ to load SciTS Conf SINA Registrants report 4.10.11-clean.csv

Run ‘Data Preparation > Extract Bipartite Network’

With parameter values:

Optional: Calculate Node Degree

Visualize resulting ‘Bipartite network

A | B | [
_1 |Last Mame Org Organization-Cleaned
_2 |Agoulnik edu Brigham and Women's Hospital, Harvard Medical School
_3 |Amaral edu Northwestern University
_4 |Bates edu University of lllinois at Chicago
_5 |Bennett gaov MIH
_B |Bietz edu University of California, Irvine
_7 |Bighop edu University of Tennessee

g .

_9 |Lotrecchiano  orgedu George Washington University
10 |Lusina ca,edu Centre for Hip Health & Mobility

\% Sci2 Taoal

File [DataPreparation Preprocessing  Analysis |

Rermowe ISI Duplicate Records

Rermowe Rows with Multitudinous Fields

Extract Directed Netuork
Extract Bipartite Metwork
Extract Paper Citation Metwork

5 Bxtract Bipartite Network ==

Extract a bipartite network from two columns in the table, I the
column values may list multiple entries, enter the special text
which delimits thern.

First colurnn [Last barne -
Second column [ora -
Test Delimiter 1
Aggregate Function File C/Users/User/Desktop/NWB-Sci2/sci2-v0.5-alpha

from Last Name and Org’ using ‘Visualization > Network > GUESS” and

Layout > GEM’, T.ayout > Bin Pack’

33
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Size coded by degree.
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Sci2 Tool — Visualize Workshop Attendees

Use File > Read’ to load SciTS Conf SINA Registrants report 4.10.11-clean.csv

A | B | [
_1 |Last Mame Org Organization-Cleaned
_2 |Agoulnik edu Brigham and Women's Hospital, Harvard Medical School
_3 |Amaral edu Northwestern University
_4 |Bates edu University of lllinois at Chicago
_5 |Bennett gaov MIH
_B |Bietz edu University of California, Irvine
_7 |Bighop edu University of Tennessee

g .

_9 |Lotrecchiano  orgedu George Washington University
10 |Lusina ca,edu Centre for Hip Health & Mobility

Run ‘Data Preparation > Extract Bipartite Network’

With parameter values:

Optional: Calculate Node Degree

Visualize resulting ‘Bipartite network

\% Sci2 Taoal

File [DataPreparation Preprocessing  Analysis |

Rermowe ISI Duplicate Records

Rermowe Rows with Multitudinous Fields

Extract Directed Netuork
Extract Bipartite Metwork
Extract Paper Citation Metwork

==

7| Extract Bipartite Network

Extract a bipartite network fram twa calumins in the table, FFthe
colurnn values may list multiple entries, enter the special text
wrhich delimits therm,

- (@]
v (@]
o] (@]

First colurnn Last Mame

——
Second colum Y
4

Organization-Cleaned

Text Delimiter

Aggregate Function File  Ci/Users/User/Desktap/NWB-Sciz/sciz-vll S-alpha

from Last Name and Org’ using ‘Visualization > Network > GUESS” and

Layout > GEM’, T.ayout > Bin Pack’

Sci2 Tool —

Visualize Workshop Attendees

. _8. 0
RIS S
0% q® [ ] o
0 e® o0 0o @ Py
e ® o.o o 1) @
- o
o9 ... . Morthwestern University

® e 0®

..o.. ° e

°

: o ©®

®oeo o o

¢ o o ° ] Olkin

°

e o ° e
o e 4 ® [ ]

e o ®
e 0 .
oo e L ] Q
[ ] [ .ThﬂmwnR&uters

Kemin Industries

. Purdue University

°
o © ®
o ©

[ ] ® o .IndianaUniversity

. . ‘ University Of California, Irvine

[ ] .ShanfnrdUnivera'ty ® o

. University E%Bm.ral Florida

Q ‘ Last Name
@ Affiliation
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T Based on Holly’s EndNote File

Sci2 Tool — Visualize SciTS Co-Author Network

Open Holly’s Sci1S-Library-03-04-2011.en/’ in EndNote and save as SeTS-Library-03-

04-2011.enw’ following instructions on
http://cishell.wiki.cns.iu.edu/Endnote+Export+Format

Use File > Read’ to load SeTS-Library-03-04-2011.enw’
Run Data Preparation > Extract Co-Occurrence Network’

Wlth parameter ValueS: 5| Extract Metwark from Table

Extracts a netwark from a delimited table

Column Mame Authors

Text Delimiter |

Optional: Calculate Node Degree

Visualize resulting ‘Bipartite network
Sfrom Last Name and Org’ using ‘1 isualization > Network > GUESS” and
Layont > GEM’, Layout > Bin Pack’

37

Based on Holly’s EndNote File

Sci2 Tool — Visualize SciTS Co-Author Network

Network Analysis Toolkit (NAT) was selected.

Implementer(s): Timothy Kelley

Integrator(s): Timothy Kelley

Reference: Robert Sedgewick. Algorithms in Java, Third Edition, Part 5 - Graph
Algorithms. Addison-Wesley, 2002. ISBN 0-201-31663-3. Section 19.8, pp.205
Documentation: .
http:/ /wiki.cns.iu.edu/display/ CISHELL/Network+Analysis+Toolkit+%28NAT%29
This graph claims to be undirected. . 5

Nodes: 706
Isolated nodes: 100 - Ls . ) 3 -
Node attributes present: label C. - w

Fdges: 1687 ¥ v .
No self loops were discovered. : 5
No parallel edges were discovered.

Fdge attributes:

Did not detect any nonnumeric attributes.

Numeric attributes: : . © - E
minmaxmean L B o — $
weight  151.15412 . 5 . °

This network seems to be valued. .. : b

L.

Average degree: 4.779 . = &
This graph is not weakly connected. "

There are 223 weakly connected components. (100 isolates)

The largest connected component consists of 73 nodes.

Did not calculate strong connectedness because this graph was not directed.

Density (disregarding weights): 0.0068
Additional Densities by Numeric Attribute

-

706 Authors

38




~Atoolfor

Lo oi‘ci!mm
arch & practice

Sci2 Tool -
Based on Holly’s EndNote File

Visualize SciTS Co-Author Network

Largest “Giant” Component

OMDSBI’, R.

qé@s@art
(o} Ta,n#,déékl.ng' y
5

'Hf O Berger, N.
J

€
OGDTE Feng, A.
e o
0-0 %
@ >
o Stokels, D.
Misra, §
® o0
Trochim, W
O Baeztonde@atbanati, L.
(0] i
a OF’B @F@sn ! Fugua, J.
Coltyy, 5° M.
oUnger, J.
.Mu’gaw}.
Harvey, R.
a
of o]
e .m.,cr;:to S
Q o} o
a

SIEI.d Q'FI!'HHquist, M.

o
o
(o] o S
o0 - -
o) 4 5 Weak Component Cluster of 73 nodes

o %%, Metwork with degree attribute added to node list.4
O'Maser, R P. 2, Weak Component Cluster of 50 nodes
','. Weak Component Cluster of 33 nodes
2, Weak Component Cluster of 25 nodes
~~~~~~~~~~ %2, Weak Component Cluster of 17 nodes
Weak Component Clustering
Implementer(s): Russell Duhon
Integrator(s): Russell Duhon
Documentation:

http:/ /wiki.cns.iu.edu/display

','. Weak Component Cluster of 14 nodes
2, Weak Component Cluster of 12 nodes
%2, Weak Component Cluster of 12 nodes.2
','. Weak Component Cluster of 11 nodes
2, Weak Component Cluster of 8 nodes

Input Parameters:

Number of top clusters: 10

223 clusters found, generating graphs for the top 10 clusters.

Node Degree was selected.

Implementer(s): Timothy Kelley

Integrator(s): Timothy Kelley

Documentation: http://wiki.cns.iu.edu/display/ CISHELL/Node+Degree
GUESS was selected.

Author(s): Eytan Adar

Implementer(s): Eytan Adar (GUESS), Russell Duhon (tesizeLinear, colorize fix)
Integrator(s): Russell Duhon

Reference: Adar, Eytan, "GUESS: A Language and Interface for Graph Exploration,"
CHI 2006 (http://graphexploration.cond.org/)

Documentation: http://wiki.cns.iu.edu/display/ CISHELL/GUESS

Sci2 Tool -
Based on Holly’s EndNote File

Visualize SciTS Co-Author Network

.Fa]k

Bomer, Katy

Keyton, Joann

=]

—kﬁhski, Hallyd:
Stokats; Daniel

Trochim, Wluam.
Uz Brian

Contractor, Noshir . .

(o]

2, Weak Camponent Cluster of 73 nodes

2, Metwork with degree attribute added to node list,4
2, Weak Camponent Cluster of 50 nodes
%2, Weak Camponent Cluster of 33 nodes

(Y

%2, Weak Camponent Cluster of 25 nodes
2, Weak Camponent Cluster of 17 nodes
2, Weak Component Cluster of 14 nodes
%2, Weak Camponent Cluster of 12 nodes
%2, Weak Component Cluster of 12 nodes.2
2, Weak Camponent Cluster of 11 nodes

%2, Weak Component Cluster of 8 nodes

589 %
2007

75"
605 |~
605
555 %
218]*
611
G281

l602]
EiE]
l604]
605
608
607 |
ENE]
EuE]
B0
B11

Stipelman, B.
Stokaols, D.
Stokols, Daniel
Stone, Anthony R.
Stringer, M.J.
Subramanian, 5.
Sundstrom, Eric
Sung, M.

Sung,
Syme,

(o]

5
[B38]
39|
640
641
642]
(643
[544]
(45|
(48]
BAT

Tress, G.

Trochim, W,

Trochim, W .
Trochim, W b, K.
Trochim, W m.
Trochim, William
Trochim, Williarm k. k.
Unger, J.

Uzzi, B.

Uzzi, Brian

661
596 %
4087

48
444 1%

76"
666 |+
5958 7
3467

B8 *
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Sci2 Tool — Visualize SciTS Co-Author Network
Based on Holly’s EndNote File — Last Names

Network Analysis Toolkit (NAT) was selected. . ’ . - . 706 Authors
Implementer(s): Timothy Kelley ’

Integrator(s): Timothy Kelley d X .

Reference: Robert Sedgewick. Algotithms in Java, Third Edition, Part 5. v - S o

Graph Algorithms. Addison-Wesley, 2002. ISBN 0-201-31663-3. Section ) = . . 584 Authors
19.8, pp.205

Documentation: %

http:/ /wiki.cns.iu.edu/display/ CISHELL/ Network+Ana1y s1s+T0(,).lk1t_+

Y028NATY%29

This graph claims to be undirected.

Nodes: 584 P ' N 5\

Isolated nodes: 79 . ’ Fp ;—M& !“f ‘;&‘ t
. . . e Fran A
Node attributes present: label, totalDegree . Cd B '_"o ™ L«. o,
o 4 o =
Edges: 1472 :
No self loops were discovered. .
No parallel edges were discovered. . 2 & B
. e
Average degree: 5.0411 - a# it B
This graph is not weakly connected. §
There are 162 weakly connected components. (79 isolates)
The largest connected component consists of 183 nodes.
Did not calculate strong connectedness because this graph was not
directed.
Density (disregarding weights): 0.0086
Additional Densities by Numeric Attribute
41
'+ ) Last Names — Giant Component ?
=t @roun 9 o
o]
. . & o]
" Lazer, Pentland, Adamic, Aral, Barabasi, Brewer, ‘ - o
Christakis, Contractor, Fowler, Gutmann, Jebara,
King, Macy, Roy, Van Alstyne (2009) @
Computational Social Science. Science.
Ay : :
. Phillips o
L, .Laze‘ ]
@Barabasi 2>  Chrjstakis °
[ a o
o @cik o
. Bl . oo @Fugua o °
E.' if:ﬁv.an Alstyne o @ Ungsr e
; ‘ Dcol Palmer
@ e ®- @ D@ cress | @harvey
ontractor
g0 » P P&Pgafﬂﬁ%garba nati Qa
‘ﬂ Q .T mo .Mamus .Mofgan .. @ =]
Q. Q 4]
o .FIG: o @1 Ostipeiman o o
* 0@ ..Kl 2V 4 e" @ @ Abrams o
@ b
8= %4
Q Roessner @i v oo
0 o / @ Falk-krzesinski W
o° e Quzi b
@ @ g ° (o) —
@ o o a ','. Weak Component Cluster of 183 nodes
oy @ Q %, Weak Component Cluster of 48 nodes
a 3 2, Weak Component Cluster of 14 nodes
4 -. ',', Weak Component Cluster of 13 nodes
. (o] 4 o %2, Weak Component Cluster of 8 nodes
. » %%, Weak Component Cluster of 8 nodes.2
aQ .. ','. Weak Component Cluster of 7 nodes
%%, Weak Component Cluster of 6 nodes
a %2, Weak Component Cluster of § nodes
L o—=a ','. Weak Component Cluster of 5 nodes.2
a
oo 42
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EQ® 3 Workshop Overview

1:15 Macroscope Design and Usage & CIShell Powered Tools: NWB & Sci2
1:45 Sci2 Tool Basics
» Download and run the tool.

2:00 Sci2 Sample Workflow: Padgett's Florentine Families - Prepare, load,
analyze, and visualize family and business networks from 15th century
Florence.

2:30 Sci2 Sample Workflow: Studying Four Major NetSci Researchers.

» Load and clean a dataset as text file; process raw data into networks.
»  Find basic statistics and run vatious algorithms over the network.

»  Visualize as either a circular hierarchy or network

3:30 Break

4:00 Sci2 Demo I: Geospatial maps with congressional districts

4:30 Sci2 Demo II: Evolving collaboration networks

4:45 Outlook and Discussion

5:00 Adjourn

43

Padgett's Florentine Families - Compute Basic
Network Properties & View in GUESS

» Florentine families related through business ties (specifically, recorded financial
ties such as loans, credits and joint partnerships) and marriage alliances.

» Node attributes
Wealth: Each family's net wealth in 1427 (in thousands of lira)
Priorates: The number of priorates (seats on the civic council) held between
1282- 1344
Totalties: The total number of business or marriage ties in the total dataset of
116 families.

» “Substantively, the data include families who wete locked in a struggle for political
control of the city of Florence around 1430. Two factions were dominant in this
struggle: one revolved around the infamous Medicis, the other around the
powerful Strozzis.”

» http://svitstv25.epfl.ch/R-doc/library/ergm/html/florentine.html
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Padgett's Florentine Families - Compute Basic
Network Properties & View in GUESS

> Load *yoursci2directory*/ sampledata/ socialscience/ florentine.nwb

» Run Analysis > Network Analysis Toolkit (NAT)’ to get basic properties.

This graph claims to be undirected.

Nodes: 16

Isolated nodes: 1

Node attributes present: label, wealth, totalities, priorates
Edges: 27

No self loops were discovered.

No parallel edges were discovered.

Edge attributes:

Nonnumeric attributes:

Example value

marriag...T

busines...F

Average degtee: 3.375

There are 2 weakly connected components. (1 isolates)
The largest connected component consists of 15 nodes.
Did not calculate strong connectedness because this graph was not directed.
Density (distegarding weights): 0.225

» Select network and run ‘Visualization > GUESS’ to open GUESS with file loaded.

» Apply ‘Layout > GEM".
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=10l x|
== =0
‘‘‘‘‘‘‘‘‘‘ | % MWE File; CH\Dacuments and SettingsikatylC
GUEhSS (W)as sa\atteg- -7 Distribution of degres For network at st
Withor (s): Eyvtan Adar 4w |
b et N Eika: e PR Pl B e Setinesrs colib et T of edges of network created through th
ntegratoris): Russell Duhon W Distribution of degres For network at sty
Reference: Adar, Eytan, "GUESS: A Language and Interface For Graph Exploration," CHI 2006 (http://graphexploration.cond.org/) -4} Distribution of degres For network at st
Documentation: https://nwb.slis.indiana.edu/c ity ? i lizeData.GUESS S =
il MWE File: C:\Documents and Settingsikaty|C
Etarting GUESS. .. raph and Metwork Analysis Log
ECHO is off, equence of site betweennesses for not
IThe initial layout Far your visualization is random, For a clearer visualization, please run a layout From the Layout menu. (We recommend GEM.) | A2 Distribution of site betweenness For netl
ECHO is of . 5
AP D i
KGLESS log file For this session can be found in H .,1‘. Distribution of site betweenness for nety
K2\ DOCUME~11katyiLOCALS~ 14 TemplCIShel-Session-55692) StaticExecutableRunner-55904 ALGORI THM guesslag, kxt g« NWE File with site betweenness attribute
""""" = x
GLESS was selected, 08 LtlEsS =101
Wuthor(s): Evtan Adar File Edit Layout Script  Wiew  Help ‘
Implementer(s): Eytan Ad:
ntegrator(s): Russel Duty Medici-Acciaiuoli 4
Reference: Adar, Eytan, " | 2 — = S oo Rl
Documentation: https:/ /1| B Field I Yalue
ECHD is off, § __edgeid 0
ptarting GUESS. .. = |busingss F
o cff, % color dandelion
[The initial layout far your v | £
ECHO is off, 5 [directed Falss
IGLESS log file For this sess | 5 |label
(CA\DOCUME-1 kabyiLOCA | — llahelcalor 0,0,0,255
labelsize 12
= Schadu\er| labelvisible Falss
e marriage T
Remove Fram List I F nodel 23
node2 nl
visible true
weight 1.0
I [Agorthmn| 0 el
GUESS
GLUESS
] Node Betw
[+ Metwork Ar
v Load...
| GruPlat
S +/| @nuPlok
i ot Object: | Property: | ~| operator: Value:
~| Degree Dis 2
o i | Barabési- Colaur ‘ | Shaw | ‘ Hide ‘ | Size | | Show Label | ‘ Hide Label | | Change Label
| GnuPlok
¥ Degree Dis | Mode Shape ‘ | Center ‘ | Change History |
¥ GUESS
v Load...
 Interpreter | Graph Madifier i
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iBix Pan:
File Edit Layout Script  Yiew Help “grab” the background
Medici | by holding left-click
z— ; .
S| Field [ value J and moving your
é color cornflo...
< [fixed false mouse.
B jheight 10,0 a
§ image
' [label Medici /.0o0m:
— |labelcolor 0,0,0,... .
labelsize 12 Using scroll wheel,
labeki... false ‘i‘ﬂ ptess the “+” and “-”
name n9 .
buttons in the upper-
p:io:;tes 53‘:| = Colar... left hand corner, or
stroke... cadetb... . .
e 2 i::”"e right-click and move
fotalities 5+ o Fd the mouse left or right.
visible  true -0 odiry Field. ..
weath 103 m Copy as Yariable. .. Cente.r gr?‘ph by
width  10.0 selecting “View ->
X 90,625, >
) PP e Center’.
* Select % to
. 4 R
select/move single
Object: | |V| Property: |Iabelsize v| Operator: Walue: EI / g
nodes. Hold down
| Colour | | Shiow ‘ | Hide | | Size | | Show Label | | Hide Label | | Change Label | ‘Shift’ to SCICCt
| Format Node Labels | | Faormat Edge Labels | multlple
‘ Mode Shape | | Center | | Change History |
| Resize Lingar | | Colorize | nght Cth to mOdlfy
Color, etc.
|N0des v| |Iabelsize v| From: | | Ta: | | | Do Resize Linear
Interpreter  Graph Modifier }
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Graph Modifier:
" I-¥isualization - GUESS N [m] |
13 bR b
File Edit Layout Script  Wew Help | Select a].l nOdes mn the Ob]ect
Pucci |f drop-down menu and click ‘Show
z
5 Field | Value ,J Label’ button.
S color 255,25...
c [fixed False
‘é height 5.0 ‘ Castellani;) P . .
& mage T Select ‘Resize Linear > Nodes >
5 |label Pucci . Barbadorr) e,
ST Lam HESERD) peruzzi Salviatty totalities’ drop-down menu, then
labelvi.. aue i‘d . A type “5” and “20” into the From”
name niz
erighal... Pucd pr e and To” Value box separately.
priorates 0 Bischeri) Ridalfi:) . L ¢ . . ,
stroke... corett., . Mesier) Then select ‘Do Resize Linear’.
style 2
i?st‘:II\:es ;rue . Tomabuonis) Acciaivaliy
vesth 3 Ly Select ‘Colotize>
dth 5.0 ..
T Nodes>totalities’, then select
A rﬂ Pucci) white and enter (204,0,51) in the
pop-up color boxes on in the
A “From” and ““To” buttons.
av
Object: | |" Property: |Iabelsizs 'l Operatar; Value: El
(13 2
‘ Calour | | Show ‘ | Hide: | | Size | ‘ Shaw Label ‘ | Hide Label | | Change Label | SeleCt Format NOde Labels >
|| Farmat Mode Lahels | | Format Edge Labels ‘ replace defﬁult text {Orlglnaﬂabel}
‘ Mode Shape | | Center | | Change History | Wlth your own label n the pop_up
¢ . .
box ‘Enter a formatting string for
node labels.’
Inkerpreter | Graph Modifier /
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. -¥Wisualization - GUESS

File  Edit Lavout

Script  Wiew  Help

=10l x|

Acciaiuoli:)

4

Field | Value

M

fixed false

image

label Acciail,..
labelcolor 0,0,0,...
labelsize 12
labelvi... true
name ni

original. .. Acciaiuoli
priorates 53
stroke... cadetb...

=| color 255,24,

5l |height  5.6635...

style 2
totalities 2

wisible  true
wealth 10

width 5.6635...
x 112.01...
' 70.315...

o+
@

Puccis)

B ERBE

Castellani;)

Alkizzi)

Guadagni)

Tornahbuoniz)

=== resizeLinear(totalities,5,20)
=== colorize{wealth,white,red)
ey

. Barbadort) Ginari)
Lamb 2HESERT) Peruzzi) Salviati;)
Strozzis) _
Bischeriz) Ridalfi) Pazzi)
Medici:)

Acciaiuoli:)

Interpreter:

Uses Jython a combination of Java
and Python.

Try
colorize(wealth, white, red)

i Interpreter /f' Graph Modifier)-"
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Workshop Overview

1:15 Macroscope Design and Usage & CIShell Powered Tools: NWB & Sci2
1:45 Sci2 Tool Basics
» Download and run the tool.

2:00 Sci2 Sample Workflow: Padgett's Florentine Families - Prepare, load,
analyze, and visualize family and business networks from 15th century
Florence.

2:30 Sci2 Sample Workflow: Studying Four Major NetSci Researchers.

» Load and clean a dataset; process raw data into networks.

»  Find basic statistics and run various algorithms over the network.

» Visualize as either a circular hierarchy or network.

3:30 Break

4:00 Sci2 Demo I: Geospatial maps with congressional districts

4:30 Sci2 Demo 1I: Evolving collaboration networks
4:45 Outlook and Discussion

5:00 Adjourn
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A ool for

st Seiaticn

Studying Four Major NetSci Researchers (ISI Data)
using Database (section 5.1.4)

FourNetSciResearchers.isi

| 1955-2007

Time frame:

Region(s): | Miscellaneous
Topical Area(s): | Network Science
Analysis Type(s):

Paper Citation Network, Co-Author Network, Bibliographic

Coupling Network, Document Co-Citation Network, Word Co-

Occurrence Network

Thomson Reuter’s Web of Knowledge (WoS) is a leading citation database. Access it
via the “Web of Science” tab at http://www.isiknowledge.com (note: access to this

database requires a paid subscription). Along with Scopus, WoS provides some of
the most comprehensive datasets for scientometric analysis.

To find all publications by an author, search for the last name and the first initial
followed by an asterisk in the author field.

bitp:

sci2.viki.ons.in.edn/ 5. 1.4+Studying+Four+Major+NetS ci+Researchers+ (151 +Data)
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1 for

e of beionce
ghdarch & practice

Data Acquisition from Web of Science

In Dec 2007, we downloaded

all papers by

» Bugene Garfield

> Stanley Wasserman

» Alessandro Vespignani

» Albert-1.4sz16 Barabasi

from

» Science Citation Index
Expanded (SCI-EXPANDED)
--1955-present

Social Sciences Citation Index

(SSCI)--1956-present

Arts & Humanities Citation
Index (A&HCI)--1975-present

aloixi

" qe (5 W5 B Ereerrmrp—————

o @ gl v Mecman O Sewh S Cutoman... S i

. DiMetscape » [ oo B i ] - Foe-es eckest: u [ T

# Coar Browser Histoey Mlbews L2Emal

o} "309

) M T | % 151 Wl of Knmdeciyn [v3.0]

151 Web of Knowledge™
Web of Science®

remucoun | | wur| O SHER] Dy iacs

CTETTR—|

e
D]
General Search

Salact databasa(s) and timospan: | seiinee 4 |

Gitation Databases:

i Scence Citation Index Evpanded (SCI-EXPANDED)--1955-presant
i Socil Sckences Citation Index (SS5CT)--1956-prasant

4 Arts & Humanities Citation Index (ABHCI)--1975-present

© vesr [5e97 =]

Gnter tarems or pheatis SHparated by thi OPeTAton AND, OR, NOT, or SAME, and thin press STARCH,
The search wil be added to the search history. [x Vigw your search history/combing sets]

st | [cvinn
TOPIC: g Gotar ong or moew barss. Saseches with actichs tles, baywords, and abstracts.
Exarpie; o gpdl® AND *North 5ea” (Wow to search for pheases
[ Titla anly

| AUTHOR: i Enter one or more author names (see guthor index ©).

Exarnply; CIEIAN C* 08 OBRIAN £°

Author Findar: Miwd badp frdesg papers by am author? Use author Findar.

GROUP AUTHOR: f EAtr cnp of mors greap names (309 Group suthor indis K0).
Exienph: CEN
I

SOURCE TITLE: ) Enter full joumal tithes (see fill source tithes kst ).
Exarnple: Cancer® OR Joumnal of Cancer Research and Climcal Oncology
[

PUBLICATION YIAR: ) Oriter & publication year or rangs.
Exampie: 2001 or 19971999

ADORESS: 1 Erter abbreviated terms from an author's affliaten (use gbbreviatons halg).
Exarnpio: Yabe Univ SAME hosp

Restrict search by languages and document types:

e o e sTART it |

il gL Gana

€ Latest [T vest ] {updated Docember 09, 2007}
= From [1335 =) to [5657 =] (defauit is all years)

To remesrbir thise settings, frit §ian in or cegrtar.

=i
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Comparison of Counts
No books and other non-WoS publications are covered.

Age Total # Cites Total # Papers H-Index

Eugene Garfield 82 1,525 672 31

Stanley Wasserman 122 35 17

Alessandro Vespignani 42 451 101 33

Albert-Laszl6 Barabasi 40 2,218 126 47 (Dec 2007)
41 16,920 159 52 (Dec 2008)

44 30,102 201 68 (April 11)
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Extract Co-Author Network

Load*yoursci2directory™/ sampledata/ scientometrics/ isi/ FourlNetS ciResearchers.isi’
using 'File > Load ...*

And file with 361 records appears in the Data Manager.

Duplicates were removed, author names normalized. Log file exists.

\ Sei2 Tool =1 Eo|=%=)
File Data Preparation Preprocessing  &nalysis  Maodeling  Misualization  Help
= Cunsule] O Data Manager] =
T T (] IST Data: Ciolsers\User\Desktop\10-NEH -A&H-Warkshop)
Rernoved 0 duplicate records, 361 Unique I3[ Records

Author names have been normalized.

361 records with unique IST1Ds are available via Data Manager

Wrote log to
CillsersiUserAppDatatlocal\Ternphisiduplicaterernoverlog 2534733093422022
8l o=
|
=2 Schedu\er] =a

Remowe From List | [7] Remowve completed automatically | Rernove all complete

! Algorithm Name Date Tirme %

| Laad and Clean IS File 08/15/2010 072043 P

E|‘ Load and Clean [SIFile 08/15/2010 07:12:49 PM | -
< 1

1 [ r
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Extract Co-Author Network
(see section 5.1.4.2 on corvecting duplicate/ misspelled anthor names)

To extract the co-author network, select the 367 Unigue 151 Records’ table and run
‘Data Preparation > Extract Co-Aunthor Network’ using isi file format:

Extracts a co-authaorship netwark Fram one of several supparted File
tvpes.,

x|

File: Forrmat Iisi

=l
Cancel |

The result is an undirected but weighted network of co-authors in the Data Manager.
Run ‘Analysis > Network > Network Analysis Toolkit (NAT)’ to calculate basic
properties: the network has 247 nodes and 891 edges.

Use ‘Analysis > Network > Umweighted and Undirected > Node Degree’ to calenlate the number
of neighbors for each node independent of co-authorship weight.

To view the complete network, select the ‘Extracted Co-Authorship Network’ and run
Viisnalization > Networks > GUESS".

Network is loaded with random layout. In GUESS, run Tayout > GEM’ and ‘Layout
> Bin Pack’ to improve layout. Run "Seript > Run Script ..." and select '
yoursci2directory/ seripts/ GUESS / co-anthor-mw.py'.
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Co-Author Network of all Four NetsSci Researchers

Node Size & Color
Number of Papers

Edge Size & Color
Number of Times
Co-Authored

L 127
Eugene Garfield .

5 1

| |
1 127 1 3
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Co-Author Network of all Four NetsSci Researchers

Use the GUESS Graph Modifier to change
color and size coding.

Calculate node degrees in Sci2 Tool.

Use a graphic program to add legend.

Node Size & Color Edge Size & Color
Nurnber of Paper Number of Times

Co-Authored

o 127
Eugene Garfield 3

35
“i) 1

1 127 1 33
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Individual Co-Author Networks
(Read/map 4 files separately)

Alessandro Vespignani Albert-I.aszl6 Barabasi
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Network Visualization:
Node Layout

Load and Clean ISI File was selected.
Loaded 361 records.

Removed 0 duplicate records.

Author names have been normalized.

361 records with unique ISI IDs are available
via Data Manager.

Extract Co-Author Network was selected.
Input Parameters:

File Format: isi

Network Analysis Toolkit (NAT) was selected.

Nodes: 247 .
Edges: 891 S =4
L] ]
.......... e \® %/ o . .
N\l \
GUESS was selected. N\ o . L]
| Draim 2 . LR
° : 5
o o’ VAt
o/ U o Se®
\ / L]
[ .. [ & ”Q.
-y &9 [ SRR
59
feitory Network Visualization:
e . . .
Y Color/Size Coding by Data Attribute Values
[
[ ]
-.
1
25 Visualization - GUESS
File Edit Layout Script  Wiew  Help
Yespignani, A N
_§ Field | Value o
§ color 125,12,17,255
5 fized false a ..l.:
B height 10.0 .
= [mage
'E [label Wespignani, A L
— |labelcalar 0,0,0,255
labelsize: 1z - -
labelvisible false ® Node Size & Color Edge Size & Color
name ni61 ® Number of Papers Number of Times
numberofworks 101 o Co-Authored
originallabel Wespignani, A [ —
strokecolor black g % F‘ il 33
skyle z ® 9
timescibed 3811 = 1
visible true ° G5l
(T N R
X 586,75
$ pgl B 1 127 1 3




Bisiter g Network Visualization:
Giant Component

frakdarch & practice

Weak Component Clustering was selected.
Implementer(s): Russell Duhon
Integrator(s): Russell Duhon

Input Parameters:
Number of top clusters: 10
3 clusters found, generating graphs for the top 3 clusters.

61

Network Visualization:
Color/Size Coding by Degree

Node Degree was selected.

Documentation:
https://nwb.slis.indiana.edu/community/?n=AnalyzeData.No
deDegree - }
.......... L] L .

. ? (]

. ra /i e

62




s or Network Visualization:
Color/Size Coding by Betweeness Centrality

e rl-ol!.'cirnco

AP\ azquez, A
g Pastor-satoffas, R
.

Node Betweenness Centrality was selected. J
Author(s): L. C. Freeman

Implementer(s): Santo Fortunato

Integrator(s): Santo Fortunato, Weixia Huang

Reference: Freeman, L. C. (1977). A set of measuring centrality

based on betweenness. Sociometry. 40;35-41. *

Input Parameters:
Number of bins: 10

umber of bins: 10
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fosl ox Network Visualization:
Reduced Network After Pathfinder Network Scaling

Sl a0t Sciatice
'arch & practice

LS00 eMakeev, MA o e ..
OVicgk T . . Aﬂ\' HE &
. - % -
. esom H
i g kahng B
2=
e W18 L 3
W e - o} |
== » ) el
e . W ghabas, AL 3
L i .zym‘s/
sschllorn P ¢ | Lt ’ 1 ®Pastorsatoras, Re sLorste, V
- ‘. a -
®0tval, IN = ’/é
; 3 sphgnanl, A |
o evadez, A I %
SAYenL R eFetonen, L .
£4: . eBarthelemy, M
. . Y .éll‘d, A
MST-Pathfinder Network Scaling was selected W . A

f * BWassurmn, § -

Input Parameters:
Weight Attribute measures: SIMILARITY /2 R
Edge Weight Attribute: weight
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Network Visualization:
Circular Hierarchy Visualization

Select Co-Author Network and run Blondel Community detection:

File Data Preparation Preprocessing | Analysis | Modeling

Wisualization  Help

Loaded 361 records,
Rermoved 0 duplicate records,
Author names have been normalized,

361 records with unique ISTIDs are available via Data Manager.,

Wrote log to

Tt

CihUsers\UsersdppDatatlocal\ Ternphisiduplicaterernowverlog4773522398971021

4 ISI Data: ChlsersiUse
4 7] 361 Unique ISI Red
7, Bxtracted Co-4

Author inform

El console Temporal 4 = B | 44 Data Managerl
.......... Geospatial 4 F -
- IS Data: CAL UsertDesktoph10-MEH-A&H-WorkshophDWDNsci? |
Load and Clean IZI File was selected, Topical v 4 E—| ;ﬁfu \ SE;;;RSH\ des ee IR REERETITI
Author(s) Micah Linnemeier P CHE:: mgue ecords
Implernenter(sh Micah Linnemeier Metworks 4 Metiork Analysis Toolkit (MAT) on
Integratoris): Micah Linnemeier MetSciResearchers.isi
Docurnentation: Unweighted & Undirected * lermeraed
IL1ll[;s:.fd.fnwh.slis.indiana.edu."cum munity/?n=LoadData.ISILoadAr Weighted & Undirected v Clustering Coefficient
oaded:
Clsers\User\Desktopt 10-NEH-A8H-\Wark shop DVDNsciZysample Unweighted & Directed 4 Mearest Meighbar Degree
ornetricshisivFourMetSciResearchers.isi \feighted & Directed N Strength vs Degree

Degree & Strength

Awerage Weight vs End-point Degree
Strength Distribution

Weight Distribution

Randomize Weights

Blondel Community Detection

With parameter values

algorithm,

7| Blondel Community Detection

This algatithrn implements Blondel's community detection

==

Weight ’numberofcoauthoredworks

-J[@]

Network Visualization:
Circular Hierarchy Visualization

Visualize resulting file using ‘V7Zsualization > Networks > Circular Hierarchy’

with parameter values

2 Circular Hierarchy

Prowides Circular Hierarchy Yisualization on the netwark,

Degree of Edge Bundling 0,73

Mode Strength Colurnn ’timescited

Lewel 0 [blondel_community_level_ﬂ
Lewel 1 [blondel_communit}f_level_l
Lewel 2 [blondel_communit}f_levelj
Lewvel 3 ’No Lewel

Edge Weight Colurnn ’numberofcoauthoredworks

Mode Color Colurmn ’numberof\morks

Mode Color Range ’Green to red

=
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e, Network Visualization:
Circular Hierarchy Visualization

it of

Nodes that are interlinked/ clustered e
are spatially close to minimize the ;

number of edge crossings.

Node labels, e.g.,

author names.

Network structure !

using edge bundling. i

hierarchy according to
Blondel community

detection algorithm. MNode Color

bazed on NUMEEROFWORES artribate
. = 1 a4 g
Note: =

Header/footer info, legend, and more meaningful color coding are under development. .
;

Paper-Citation Network Layout

To extract the paper-citation network, select the 367 Unigue IS1 Records’ table and run
‘Data Preparation > Extract Paper Citation Network.

The result is a unweighted, directed network of papers linked by citations, named
Exctracted paper-citation network in the Data Manager.

Run NAT to calculate that the network has 5,342 nodes and 9,612 edges. There are
15 weakly connected components. (0 isolates)

Run Analysis > Networks > Unweighted and Directed > Weak Component Clustering’ with
parameters

| weak Component Clustering eak Component Cluster of 5151 nodes

Creates new graphs containing the top connected components,

Mumber of top clusters | 11|

to identify top-10 largest components. The largest (giant) component has 5,151 nodes.

. Weak Component Cluster of 38 nodes
. Weak Component Cluster of 35 nodes
> ak Component Cluster of 27 nodes

e
. We

i
i
i
i
Weak Component Cluster of 27 nodes.2
i

eNgNgNgNagNeN
PO G Qi S

eak Component Cluster of 15 nodes

To view the complete network, select the network and run ‘VZsualization > GUESS".
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Topic Mapping: UCSD Science Map

Science Map via Journals for FourNetSciResearchers.isi

314 journal references matched our of 361 found.

These 314 references are associated with 13 of 13 disciplines of science and 233 of 554 research specialties in the UCSD Map of Science.

@

o

Barth Sciences

B Science Map ==
Locate the journals from a table on the UCSD Map of Science
Journal calumn Journal Hame {&bbreviated) '| ‘-9-|
Dataset display name  FourMetSciResearchers.isi "9|

| oK ||Eancal‘

= Q. E
.?;E%’@éfr oo
A U)

-, @ Aatectious Diseas

Data:

WoS and Scopus for 2001-2005, 7.2 million
papers, more than 16,000 separate journals,
proceedings, and series

Similarity Metric:
Combination of bibliographic coupling and
keyword vectors

Number of Disciplines:

554 journal clusters further aggregated into 13
main scientific disciplines that are labeled and
color coded in a metaphorical way, e.g., Medicine
isblood red and Earth Sciences are brown as soil.
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How to Read the UCSD Map

UCSD Science Map
with data overlay. —

Map legend of ——
circle area size

coding

Listing of all data —
records organized int
UCSD science areas.

Circle of non-located,
e.g., ‘Unclassified’
records.

Header and footer with
information when this
map was created, by
whom and using what
data set.

Listing and circle of
non-located, e.g.,
‘Unclassified’ records.
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Workshop Overview

1:15 Macroscope Design and Usage & CIShell Powered Tools: NWB & Sci2
1:45 Sci2 Tool Basics
» Download and run the tool.

2:00 Sci2 Sample Workflow: Padgett's Florentine Families - Prepare, load,
analyze, and visualize family and business networks from 15th century
Florence.

2:30 Sci2 Sample Workflow: Studying Four Major NetSci Researchers.

» Load and clean a dataset as text file; process raw data into networks.
»  Find basic statistics and run vatious algorithms over the network.

> Visualize as either a circular hierarchy or network

3:30 Break

4:00 Sci2 Demo I: Geospatial maps with congressional districts
4:30 Sci2 Demo II: Evolving collaboration networks

4:45 Outlook and Discussion

5:00 Adjourn
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Sci2 Demo I:
Geospatial maps with congressional districts

A Identify Congressional District, Latitude, Longitude
1 | Zip code )
2 90095 A B £ D
3 2572 1 Zipcode Congressional District Latitude Longitude
4 237980568 2 90095 CA-30 34.0735035 -118.6645815
5 10032 3 4672 ME-02 45.818717  -69.0290345
6 10039242 4 | 232980568 VA-03 37.270472 -77.0699835
7 46091500
8 191112434
9 27705 . . . . .
0| 81959472 Aggregate/Count identical Congressional Districts
11 10065 | A | B | C | D |
12 10065 1 |Congressional District Latitude Longitude Caount
2 |CA-30 34.0735035 -118.6645815 4
3 |ME-02 45816717 -69.0230345 2
4 |WA03 37270472 -77.0699835 1
5 |MY-14 408341475 -73.9342095 4
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Relevant Sci2 Manual entry

Home @ B Tools ~
Annecicton 5.3.2 Congressional District Geocoder
[ 2 Gefting Started & 14 Added by Scoft Weingar, last by Ted Polley on Mar 28, 2041 (view change
[ 3 Algorithms, Toals,
and Plugins zip code.csv
& 4 Warkflow Design
Region(s): United States
= 5 Sample Workflows
@ 5.1 Individual Level Analysis Type(s) Geospatial Analaysis
Studies - Micro
5.2 Institution Level Ta visualize Congressional Districts you must first extract that data from a dataset containing either ZIP codes or
Studies - Meso addresses. You can download the Congressional District Geocoder plugin here. You can load any file that contains
= 5.3 Global Level 9-digit U.S. ZIP codes to be geocoded. A sample file can be loaded by using 'File > Load and following this path:
Studies - Macro 'yoursic2directory/sampledat/geo/zipcode.csv'. Load the file in Standard csv format . Then select the file in the data
5.3.1 Geo USPTO manager and use "Analysis > Geospatial > Congressional District Geocoder with the following parameters:
(SDB Data) - ~
5.3.2 Congrassional % Congressional District Geocoder =R
District Geocoder
[ & Sample Science ‘Converts U.S. ZIP codes to congressional districts
Studies & Online
Senices
7 Edending the Sci2 Place Name Column |Zip.c E |
Tool
& 8 Relevant Datasets
and Tools
9 References El ancel |
Appendix 1 Glossary
Appendix 2 CIShell 5-digits ZIP codes with multiple congressional districts, empty entries and invalid ZIP codes that failed to be geocoded
Algorithms will list in warning messages on the console.The output table contains all columns of the input table with three
Appendix 3 Sci2 additional columns appended: Congressional district, latitude, and longitude To view the output table save the file
Release Notes v0.5 using 'File = Save..." and selecting the desired save location (to view the file in Excel save it as a csv file). Once the
alpha file has been saved it can be viewed with your choice of program. Below the file has been opened as a cav file:
Fl A B & B
1 |Zipcode Congressional District Latitude Longitude
= 90095 CA-30 34.0735035 -118.6645815

bhttp:/ [ sci2.wiki.cns.in.edn/ 5.3.2+ Congressional+ District+Geocoder
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Relevant CIShell plugin

gggc Igh(;l I Congressional District Geocoder £ Tools ~

&1 Added by Ted Polley, last edited by Chin Hua Kong on Mar 29, 2011 (view change)

Description

This algorithm converts the given 9-digits U.S. ZIP codes (ZIP+4 codes) into its congressiga mts and geographical coordinates

(latitude and longitude). The Benchmark is 50,000 ZIP codes per second. Download the plug

Pros & Cons

1. The algorithm is using a local database mapping with 25MB file size_ It will increase the application size dramatically. So it is build

as an external plugin

2. For first execution in the same application window, the plugin required 5 seconds to load the database. The consequent execution
will not required the pre-loading phase.

3. Since some 5-digits ZIP codes contain multiple districts, the 9-digits ZIP codes is required for the conversion. Warning message will
be printed to notice user if the given 5-digits ZIP codes contain multiple districts

4_ Congressional district might be varied by each election. The database would need to be maintained and updated relatively.

Applications

This plugin only support U.S. ZIP codes. It convert 9-digits ZIP codes to their belonging congressional district. It is an external plugin since
the data size is so large. The dataset is based on the year 2008 election.

bttp:/ [ cishell.wiki.cns.in.edu/ Congressional+ District+Geocoder
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tool for

iper orlesence Console Messages
ghdarch & practice

Load... was selected.

Documentation: http://wiki.cns.iu.edu/display/ CISHELL/Data+Formats

Loaded: C:\Users\katy\Desktop\NWB-SCI2\sci2-2011.04.04-v0.5a\sampledata\geo\zip code.csv
Congtessional District Geocoder was selected.

Implementer(s): Chin Hua Kong

Integrator(s): Chin Hua Kong

Documentation: https://nwb.cns.iu.edu/community/?n=SampleData.CongressionalDistrictGeocoder

Input Parameters:

Place Name Column: Zip code

District values added to Congtessional District, Latitude and Longitude respectively.

There are 2 rows with "33612" ZIP code, which could not been given a congressional district.
There are 1 rows with "2472" ZIP code, which could not been given a congressional district.
There are 3 rows with "10016" ZIP code, which could not been given a congressional district.
There are 1 rows with "11203" ZIP code, which could not been given a congressional district.
There are 1 rows with "60637" ZIP code, which could not been given a congressional district.
There are 1 rows with "70118" ZIP code, which could not been given a congressional district.
There are 1 rows with "60612" ZIP code, which could not been given a congressional district.
There are 3 rows with "21205" ZIP code, which could not been given a congressional district.
There are 1 rows with "2467" ZIP code, which could not been given a congressional district.
5-digit ZIP codes may often be insufficient, as many zip codes contain multiple congressional districts. 9-digit zip codes may be required. If a
zip code was recently created, it may also not be contained in our database.

Successfully converted 86 out of 100 ZIP codes to congressional districts.
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54 Sci2 Demo I:

]\rl-ol'.'cirmﬂ-

#is  Geospatial maps with congressional districts

Run Preprocessing > General > Aggregate Data’

using parameter values

5| Aggregate Data ==

Aggregate data in the table based on a column,

Delimiter for Congressional District |

Note: Need lat/long for geomap.

Input Parameters:

Aggregate on column: Congressional District

Longitude: AVERAGE

Latitude: AVERAGE

Delimiter for Congressional District: |

Zip code: NONE

Aggregated by ": All rows of Latitude column were skipped due to no non-null, non-empty values.
Aggregated by ": All rows of Longitude column were skipped due to no non-null, non-empty values.
Frequency of unique "Congressional District" values added to "Count" column.

"Zip code" column has been deleted from the output. Since No aggregation was mentioned for it.
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h & practice

Create Geo Map (Circle Annotation)

Geo Map (Circle Annotations) was selected.

Author(s): Joseph R. Biberstine

Implementer(s): Joseph R. Biberstine

Integrator(s): Joseph R. Biberstine

Documentation: http://wiki.cns.iu.edu/display/ CISHELL/Geo+Map

Input Parameters:

Longitude: Longitude

Size Circles By: CircleSize

Color Circle Exteriors By: None (no outer color)

Color Circle Interiors By: CircleSize

Exterior Color Scaling: Linear

Exterior Color Range: Yellow to Blue

Interior Color Range: Blue to Red

Size Scaling: Linear

Map: US States

Author Name:

Interior Color Scaling: Linear

Latitude: Latitude

14 rows in the table did not specify all values needed to make a citcle; those rows were skipped.
Printing PostScript..

Done.

Saved: C:\Users\katy\Desktop\geoMaps2903082942930990749.ps

Save ps file, convert to pdf, view.

5] Gea Maps (circles) ==

Creates a map with circle annotations, Circles are positioned,
sized, and colored (inside and outside) according to columns in
the input table, Either or both kinds of coloring can also be
dizabled. The table data for each dimension can be log-scaled
before processing.

=

Author Name K, Borner

Color Circle Exteriors By
Exterior Color Scaling
Exterior Colar Range
Color Circle Interiors By L4
Iterior ColorSeolng i

Size Circles By

Size Scaling
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How to Read the Geo Map

Header and footer
with information

<
<

U.S. Map with

—
data overlay.

Listing of map
type, author, and
parameters used.

— Geo Map (Circle Annotation Style)
Alber: Eqmi-Area Conic Projection

Apr 10,2011 | 09:22:16 AM

K Borzer

when this map
was created, by
whom and using
what data set.

Map legend with

color coding.




Workshop Overview

1:15 Macroscope Design and Usage & CIShell Powered Tools: NWB & Sci2
1:45 Sci2 Tool Basics
» Download and run the tool.

2:00 Sci2 Sample Workflow: Padgett's Florentine Families - Prepare, load,
analyze, and visualize family and business networks from 15th century
Florence.

2:30 Sci2 Sample Workflow: Studying Four Major NetSci Researchers.

» Load and clean a dataset as text file; process raw data into networks.
»  Find basic statistics and run vatious algorithms over the network.

> Visualize as either a circular hierarchy or network

3:30 Break

4:00 Sci2 Demo I: Geospatial maps with congressional districts

4:30 Sci2 Demo II: Evolving collaboration networks

4:45 Outlook and Discussion

5:00 Adjourn
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Sci2 Demo II:
S Evolving collaboration networks
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54 Sci2 Demo II:

]\rl-ol!.'cirnco

i@l Evolving collaboration networks

Load isi formatted file

+ osciz-vllS-alpha v sampledata » scientornetrics » isi |+

MName Date modified Type Size

i |7 AlessandroVespignani.isi i |7 EugeneGarfield.isi
| FourMetSciResearchers.isi ] LaszloBarabasiisi
7] Stanleyasserman.isi ] TestiPapers.isi

As csv, file looks like:

A | B | c | o | E | F |TWGTH
1 |Abstract Authors Authars (Full Narmes) Beginning Book Serie Book Serie Cited Pate (
2 |The systematic study ol Colizza, W|Barrat, AlBarthelemy, MVespignani, A 2015
3 |Uncovering the hidden ré Colizza, VIFlammini, AlSerrano, MANespignani, A 110
4 |Computer viruses can s)%espignani, A 135
5 |Mapping the Intemet gelDall'Asta, L|Aarez-Hamelin, l|Barrat, Alvazguez, ANVespignani, A 140 LECTURE MOTES IN

Visualize each time slide separately:

omigran, &

Petrmem L

L pre—

@ vnteen @ pemgarr
Wars

(]

1900- 1001

tool for

penolcience Relevant Sci2 Manual entry

xeifarch & practice

Home @ @ Tools ~
1introduction 5.1.2 Time Slicing of Co-Authorship Networks (ISI Data)
2 Getting Started &6 A Ted Polley, last edited by Scott Weingart on Mar 16, 2011 (view change
3 Algorithms, Tools,
and Plugins AlessandroVespignani isi
4 Workflow Design
Time frame: 1990-2006
= 5 Sample Workilows
B 5.1 Indmvidual Level Region{s): Indiana University, University of Rome, Yale University, Leiden University, International Center for Theoretical Physics
Studies - Micro University of Paris-Sud
gg";l’;‘cﬁgzlﬂnﬁ Topical Area(s): Informatics, Complex Metwork Science and System Research, Physics, Statistics, Epidemics
Publication, and Analysis Type(s): Co-Authorship Network
Funding Profiles
of One g
Researcher The Sci® Tool supports the analysis of evolving networks. For this study, load Alessandro Vespignani's publication history from ISI. which can be
(EndNote and downloaded fram Thomson's Web of Science or loaded using 'File > Load" and following this path: 'y i2di Y ‘scienfometncs
NSF Data) /fisi/AlessandroVespignani.isiusing.’ Slice the data into five year intervals from 1990-2006 using Preprocessing > Tempora! > Slice Table by Time' and the
5.1.2 Time Slicing following parameters:
of C: if
E = n
Networks (ISI @ Slice Table by Time B>
Data)
5.1.3 Funding Slice a table into groups of rows by time.
Profiles of Three
Researchers at 5 =
e Date/Time Column | Bublication Vear || &
(NSF Data) n
51.4 Studying Date/Time Format vy
Four Major NetSci <
Researchers (ISI Slice Into lvm’s
Data)
5.2 Institution Level i 3
Studies - Meso
# 53 Clobal Level Hin e 25
Sludies - Macro
6 Sample Science ToTime 2000
Studies & Online 3
v 7
Senvices Cumulative?
(T Estnnchii Bies acio. 7] Align With Calendar
Tool
8 Relevant Datasets
el Week Starts On  [Sunday

9 References

bitp:/ [ sci2.wiki.cns.in.edn/ 5.1.2+ Time+ S licing+of+ Co-Authorship+ Networks+ (1S 1+ Data)
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Slice Table by Time

F' o Y
% Slice Table by Time | B )
Slice a table into groups of rows by time,
Date/Time Column [Publicatiun Year '] E
Date/Time Format  wyyy E
Slice Into Years -l
"Slice Into" allows the userto slice the table by days, weeks, months, gquarters, years, decades, and
How Many? 5 centuries. There are two additional parameters for tirme slicing: cumulative and align with calendar. The
former produces tables containing all data from the beginning to the end of each table's time interval, which
From Time 1990 can be seen in the Data Manager and below:

= 101 Urigue ISI Records

oime 2uio ﬂ slice from beginning of 1990 to end of 2006 {101 records)
Cumblatve? slice Fram beginning of 1990 to end of 2001 {65 records)
slice from beginning of 1990 to end of 1996 (26 records)
] Align With Calendar slice from beginning of 1990 to end of 1991 {4 records)
Week Starts On @ The latter option aligns the output tables according to calendar intervals:

SRS} 101 Unique 15T Records
'ﬂ slice from beginning of 2002 to end of 2006 {36 records)

slice from beginning of 1997 to end of 2001 {39 records)
slice Fram beginning of 1992 to end of 1996 (22 records)
slice from beginning of 1990 to end of 1991 {4 records)

Choosing "Years" under "Slice Into” creates multiple tables beginning fram January 1% of the first year. If
"Months" is chosen, it will start from the first day of the earliest maonth in the chosen time interval.

bttp:/ [ sci2.wiki.cns.in.edu/ 5. 1.2+ Time+S licing+of+ Co-Authorship+Networks+ (1S 1+ Data)

Visualize Each Network, Keep Node Positions

6.

To see the evolution of Vespignani's co-authorship network over time, check ‘cumulative’.

Extract co-authorship networks one at a time for each sliced time table using '‘Daza
Preparation > Extract Co-Author Network', making sure to select "ISI" from the pop-up
window during the extraction.

To view each of the Co-Authorship Networks over time using the same graph layout,
begin by clicking on longest slice network (the 'Extracted Co-Authorship Network' under "slice
from beginning of 1990 to end of 2006 (101 records)’) in the data manager. Visualize it in GUESS
using 'Visualization > Networks > GUESS'.

From here, run 'Layout > GEM' followed by "Layout > Bin Pack'. Run 'Script > Run Script
..."and select ' yoursci2directory/ seripts| GUESS / co-author-nw.py'.

In order to save the x, y coordinates of each node and to apply them to the other time
slices in GUESS, select 'File > Export Node Positions' and save the result as

"yoursci2directory/ NodePositions.csv'. Load the remaining three networks in GUESS using the
steps described above and for each network visualization, run 'File > Import Node Positions'
and open "yoursci2directory/ NodePositions.csv'.

To match the resulting networks stylistically with the original visualization, run "Seript >
Run Seript ..." and select 'yoursci2directory/ seripts/ GUESS / co-author-nw.py', followed by 'Layont >
Bin Pack’, for each.

bitp:/ [ sci2.wiki.cns.in.edn/ 5.1.2+ Time+ S licing+of+ Co-Authorship+ Networks+ (1S 1+ Data)
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tool for

=5 Visualize Each Network, Keep Node Positions

Sdarch & practice
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bttp:/ [ sci2.wiki.cns.in.edn/ 5.1.2+ Time+ S licing+of+ Co-Authorship+ Networks+ (1S 1+ Data)
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tool for

@8 Relevant CIShell plugin

Sdarch & practice

C|Sh( ,[| Slice Table by Time £ Tools -

Added by Aretha Alencar, |ast edited by Ted Polley on Jan 12, 2011 (view change)

Description

Slice Table By Time is an algorithm to chop a table up into new tables, based on a dateftime column. It takes the column with the date/time data, a string
describing the format of that column, the intervals that the data should be sliced into, whether or not the slices are cumulative, whether or not the slices should be
aligned with the calendar, and what day the week is considered to start on (which only matters if the slices are aligned with the calendar) as parameters.

The column to use for datetime values should have a single value for each row of data. It is used by the algorithm to choose which slice(s) the row should end up
in. In order to determine what dateftime is represented by that row, you must provide the algorithm with a descriptive format, in the second parameter. For instance,

a four digit year would be represented by yyyy (the default value). See http-/joda-time sourceforge net/api-release/org/jodaftimeformat/DateTimeFormat html for
details of all the various formatting options

The next dropdown has the available intervals to slice the table into. These include milliseconds, seconds, minutes, hours, days, weeks, fortnights, maonths,
quarters, years, decades, and centuries. A future version of the algorithm may include the ability to select how many of these intervals should be grouped together
at once

The checkbox that follows determines if the slices will be cumulative. If the slices are not cumulative, every row in the original table is in one and only one resulting
slice. However, if the slices are cumulative. every row in the original table is in the slice it is for and every slice for a period after that.

The checkbox that follows determines if the slices will be aligned with the calendar. For instance, if the first row is for June 7th, 2006 and yearly slices are chosen,
then the default behavior will be to have the first slice be from June Tth, 2006 to June 6th, 2007 However, if the slices are aligned with the calendar, the first slice
will be from January 1st, 2006 to December 31st, 2006. Alignment does not affect the output for intervals of fortnights, quarters, decades, or milliseconds._

Ifthe slices are aligned with the calendar and are weekly, then the day the week starts is used to determine how they are aligned.

Pros & Cons

The output of the slice algorithm is in separate tables, so a longitudinal analysis will require working with each slice separately, which can be awkward. There will
likely be future versions of the time slice algorithm that annotate the original table with the slice the rows belong to.

Applications

When doing longitudinal analysis of data, it can be useful to consider it in chunks, such as to calculate how statistics have changed over time. Alternatively, only a
particular time period might be of interest, and this algorithm can extract it from data for a larger time range.

Implementation Details

This algorithm uses the Joda Time library extensively, which provides significantly improved capabilities compared to the default Java algorithms for dates and
times

bittp:/ [ cishell.wiki.cns.in.edu/ S lice+Table+by+Time
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Workshop Overview

1:15 Marcoscope Design and Usage & CIShell Powered Tools: NWB & Sci2
1:45 Sci2 Tool Basics
» Download and run the tool.

2:00 Sci2 Sample Workflow: Padgett's Florentine Families - Prepare, load,
analyze, and visualize family and business networks from 15th century
Florence.

2:30 Sci2 Sample Workflow: Studying Four Major NetSci Researchers.

» Load and clean a dataset as text file; process raw data into networks.
> Find basic statistics and run various algorithms over the network.

»  Visualize as either a circular hierarchy or network

3:30 Break

4:00 Sci2 Demo I: Geospatial maps with congressional districts

4:30 Sci2 Demo II: Evolving collaboration networks

4:45 Marcoscopes: Outlook and Discussion

5:00 Adjourn
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‘SD&‘ SCHOLARLY DATABASE Scholarly Database at Indiana University
bhttp:/ [ sdb.wiki.cns.in.edn

Supports federated search of 25 million publication, patent, grant records.
Results can be downloaded as data dump and (evolving) co-author, paper-citation networks.

@ SCHOLARLY D/\T»‘\P[\QF

R e e e e %g

Cyberinfrastructure for Notwork Scisnce Center, SLIS, Indiana University, Bloomingion
. THER. . R AR TN I O S - .
Search | EdtProfle | Admin | About | Logout
u IU User Non-IU User
......
o] Search
y
SISO Creators:
Title:
Abstract: [FHA
Full Teut:
First Year: | 1698 'i
Last Year: |2008 =

Sl (LA0E - 2048}

=

P i gaow - 2002
F s

=3

- Do
&1, 5em oD 07 LIBAAEY :
7 AND 1HFDRMATION SCIENCE s

Register for free access at http://sdb.cns.iu.edu
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File Edit Wiew History

Bookmarks

=10l x|

Tools  Help

c x TR IC] |http:,l’,l’sdb.slis.indiana.edu,l’search,l’results,l’?q=("artificia|intelligence") T? - I

| mark meckie umich r

@ IMosk Visited ’ Getting Started 5 | Latest Headlines |j Hotel Kénigshof - Bod...

QrHOI ARIY DATARARE]

Cybennfrastructure for Network Science Center, SLIS, Indiana University, Bloomington

Search . Edit Profile

Browse Results

Admin

Rezults 1 through 20,

“our zearch returned 13,231 results in 0,295 zeconds,

Total rezults per databaze: WIH: 2,103, Medline: 10,235, USPTO: 279, NSF: 614,

MNext>>
Source Authors/Creators Year Tite :c;i;\)a (outof
Medline LaCombe 19587 Artificial intelligence. 5.71
Medline 1989 Artificial intelligence: expert systems. 5.71
Medlime Schrnitt 1990 [Artificial intelligence in dentisty] 5.71
Madline #dlassnig and 2002  Artificial -intell g ted syst 5.60
Adlassnig
Medline Touretzky 1930 Artificial intelligence. 4,86
Medline Goldenberg 1980 Artificial intelligence. 4,86 91
¥Jscholarly Database = Download - Mozilla Firefox =0 x|
File Edit View History Bookmarks Tools Help
‘; v € 20 Gy [ [hemesohsis.indizna. edufdawnload a={"artficis nteligence’) D 7 =[G+ mark mekie umih i~
.
Most visited 4 Getting Started 5. Latest Headlines | | Hatel Kenigshof - Bod Slnce March 2009:
> (QOCHOI ARIY DATARASQF Users can download networks:
- Co-author
Cyberinfrastructure for Network Science Center, SLIS, Indiana University, Bloomington
- Co-investigator
Search | Edit Profie | Admin | About | Logout ] 1
- - g - Co-inventor
- Patent citation
Download Results d bl f
Downlasd |20000 racords starking st record |1 frarn the following databaras: an ta es Or
7 select all downloads. burst analysls m NWB.
Medline Database:
o i
'-
Medline MeSH heading table Flle Edit View Faworites Tools Help | a'
T Mediine MesH qualifier table [ =
7 Medine suthor table [ @ Back Q - Lﬁ; p Search | Folders | i3]~
™ Medine co-suthor tble (nub format) 0 -
I trodinne macter tabie I Address [[=) :\sampledatalscientometricsisdb I Be
| Mame | Size
NIH Database ¥ Files Currently on the (D
T 1K master table [T
- rs 960 KB
= File and Folder Tasks % -
NSF Database L Medine_co-author_table_(nib_format).csv 627 KB
(Z) Make a new Folder Bl Medline_master_table.csw 13,986...
I hsF cominvestigator table(nub format) [T £ Publish this folder to the | Medine_MeSH_heading_table.csv 3,453 KB
I sk master table [ web L] Medline_MeSH_gualifier_table.csv 853 KB
USPTO Database: 5 EL]MIH_master_table.csv 5,189 KB
r E Other Places 2 %]NScho—\nvestigator7tab\ef(nwbjormat).csv 19KE
USPTO Patent Cooperation Treaty table B s _master_table,csv 1,303 KB
7 Uspro agent tatle £ [ scentometrics ELJUsPTO_ co-inventor_table_(nwb_format).csv 18KE
I UspTo assignes table L m (5 My Documents EL]usPTO_agent_table.csv 20KB
I UspTo atation table (nwb farmat) L & My Network Places ELJUSPTO_sssignes_table.csv 23KB
™ UseTo daims table 5 = EL)USPTO_citation_table_{rwh_format}.csv 72KB
II: uspTa ca—muentartablEE(nwb Format) [ : ~ ELJUSPTO_inventar_table.csv Ga kB
5 O IRl m Eeal & B USPTO_master_(burst_format).csv 308 KB
- USPTO mastar (burst farmat) [ - ELJUSPTO_master_table.csv 37k
USPTO master table File Folder | EusPTo_Patent_Cooperation_Treaty_table.csv ZKB
Date Modffied: Today, Apri
Dounload | 08, 2009, 1:25 PM ~|4] | !
['pone 92
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Borner, Katy

Download Data

Genoral Statistics Enabling a National
5 st o 2001 Network of Scientists

S [ -~ l General Statistics
Co-Author Netwol )
il * 30 publication(s) from 2001 to 2010

¢ 80 co-authoz(s) from 2001 to 2010

Co-Author Network

Save as Image (.PNG file)

Tables

* Publications per year

Tables

Co-authors

Yo

Year| Publications

36 publication(s) from 2001 to 2010 2001

Enabling a National
Network of Scientists

80 co-authoz(s) from 2001 to 2010

Year Count Co-Author(s)

2001 1/ Chen C.

2002 3 Chen C.; McMahon T.; Feng Y.
2003 2 Chen C.; Boyack kOW.

2004 17 Sengupta A Penumarthy 5.; Thakur 5.; Sooriamurthi B.; Maru J.T.; Shifftin R.M.; Mane K., Moor KA

=R TR R R S R N |

Co-author network

<rxml wersion="1.0" encoding="UTF-3" >

<graphm]l xmlns="http://graphml.graphdrawing. org/xnlns"

xmlns:xsi="http: /fmmr. w3 org/ 2001 XMLSchena-instance™

xsi:schenalocation="http: //graphnl. graphdrawing. org/=nlns

hrop: ffgraphml . graphdrawing. org/xmnlns sl 0/graphml . xsd™>
id="lakel™ for="node” attr.name="lahel™ attr.type="string” /=
id="mumber_of_authored works" for="node” attr.name="number of_ authored works" attr.type="int" />
id="rum unknown publication” for="node” attr.name="rum unknown publication” attr. type="int” f>
id="rum_latest_publication” for="node”™ attr.name="mum latest_publication™ attr.type="int"™ />
id="latest publication™ for="node” attr.nesme="latest publication” attr.type="int"™ />
id="profile_url™ for="node" attr.name="profile_url™ attr.type="string” />

=

tn

=

o

=
(=)

[Ce-author network of Bomer, Katy

Save as Image (PNG file) :

Publications per year , see top file.

Co-authors Co-Author
Andrienko G.

Andrienko M.
Ben-Miled Z.
Blackwell A
Boyack KW,
Bozicevic M
Brodbeck D.
Burkhard R.A.
Chen C.
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§2CIShell

CIShell - Integrate New Algorithms

About the Cyberinfrastructure Shell

The Cyberinfrastructure Shell (C1Shell) is an open source, community-driven platform far the
integration and utilization of datasets, algorithms, tools, and computing resources. Algorithm
integration support is built in for Java and most other programming languages. Being Java based,
it will run on almaost all platforms. The software and specification is released under an Apache 2.0
License.

ClShell is the basis of Metwark Workbench, TexTrend, Sci® and the upcoming EpiC tool.

CIShell supports remaote execution of algarithms. A standard web service definition is in
development that will allow pools of algorithms to transparently be used in a peer-to-peer, client-
server, of web front-end fashion.

CIShell Features

A framework for easy integration of new and existing algorithms written
in any programming language

Using CIShell, an algorithr writer can fully concentrate on creating their own algorithm in whatever

language they are comfortable with. Simple tools are provided to then take their algorithm and

Learn More...

ClEhell Papers

ClShell Powered Tools

Algorithrns

Plugins {coming soon)

Misc. Tool Documentation

ClShell Web Services (coming soon)
Screenshots

Getting Started...

= Documentation & Developer Resources
= Download

Getting Involved...

= Contact Us

cishell.wikr.cns.in.edu

CIShell Developer Guide is at )1ip:

Additional Sci2 Plugins are aIr/Jz‘sz: sci2.wiki.cns.in.edu/ 3.2+ Additional+Plugins
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Cytoscape |

§2C|

*|1  CIShell - Add new Plugins, e.g., Cytoscape

Adding more alyout algorithms and network visualization interactivity

via Cytoscape http://www.cytoscape.org.

Simply add org.textrend.visualization.cytoscape_0.0.3.jar into your /plugin directory.
Restart Sci2 Tool.

Cytoscape now shows in the Visualization Menu.

File DataPreparation Preprocessing  Analysis  Modeling [RUEFEIEERES Help

3
| El CDD;@I@I feneral i = ii0f Data Manager|
emporal =
| Geospatial » . = 151 Data: CiiDocuments and Settingsiborne
Integrator{s): TexTrend Consortium (http:/ fwww.textrend  pebworks  # [pis (TexTrend, =! 361 Unique ISI Records
niversitas Press) =

& ape . Extracted Co-Authorship Network

Authar information

Reference: Cytoscape Consortium (hitp:/ /www.cytoscap

CADOCUME~1bornerk LOCALS~ 1) TempiCIShell-Session-6885247 7852002667994 StaticExecutable
Runner-20687 1627 1488870377\ algorithm=echo off

cytoscape. CytoscapeInit[ INFO]: CytoscapelInit static initialization

]cytoscape.Cytoscapelnit[INFO]: Parent_Dir: C:\Documents and Settingsibornerk), cytoscape
‘created.

Select a network in Data Manager, run Cytoscape and the tool will start with this
network loaded.
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& Cytoscape Desktop (New Session)

File Edit Yiew Select Layout Plugins Help

| Control Panel 9 Metwo =
'E: NEtWDrk|\n'izMa|:||:nar"4 Editor | Filters

Tetwork Modes Edges

Data Panel o)
£=
=W )
D |
Munoz,Ma |
————
Made Attribute Browser | Edge Attribute Browser | Metwork Attribute Browser
‘Welcome o Cytoscape 2.6.2 Right-click + drag ko ZO0M Middle-click + drag to PAN




& Cytoscape Desktop (New Session)
File Edit View Select JEFLUSE Plugins Help

5E Q8 o e |7

_| Contral Panel Align and Diskribute Network
Hetwork | i i
E W Settings...

Metwork
Network iJf vries 4
Cytoscape Layouts » Ny CYEWLN }
Jaraph Layouts »| Edge-weighted Spring Embedded ]

CEX

Hierarchical Layout

Circular Layout

Inverted Self-Crganizing Map Layout

Group Attributes Layout 3
Grid Layout

Force-Directed Layout »
Degree Sorted Circle Layout

Spring Embedded

Edge-weighted Force directed (BioLayout) »

Data Panel (3]
B ) = K
o |

Made Attribute Browser | Edge Attribute Browser | Metwork Attribute Browser
‘Welcome o Cytoscape 2.6.2 Right-click + drag to Z00M Middle-click + drag to PAN

°°°C |SHel| 0sGi/cishell Adoption

A number of other projects recently adopted OSGi and/or CIShell:

Cytoscape (btp:/ / eytoscape.org) Led by Trey Ideker at the University of California, San Diegois an
open source bioinformatics software platform for visualizing molecular interaction networks
and integrating these interactions with gene expression profiles and other state data (Shannon
et al., 2002).

> Taverna Workbench (bitp:/ / taverna.ors.nk) Developed by the myGrid team
(http://mygrid.org.uk) led by Carol Goble at the University of Manchester, U.K. is a free
software tool for designing and executing workflows (Hull et al., 2006). Taverna allows users
to integrate many different software tools, including over 30, 000 web services.

> MAEwig (bttps:/ [ wiki.nesa.uine.edn/ display/ MAL/ Honre) Managed by Jong Lee at NCSA is an
open-source, extensible software platform which supports seismic risk assessment based on
the Mid-America Earthquake (MAE) Center research.

»  TEXTrend (bitp:/ / texctrend.ors) Led by George Kampis at E6tvos Lorand University, Budapest,
Hungary supports natural language processing (NLP), classification/mining, and graph
algorithms tor the analysis of business and governmental text corpuses with an inherently
temporal component.

»  DynaNets (bitp:/ [ wwm.dynanets.ors) Coordinated by Peter M.A. Sloot at the University of
Amsterdam, The Netherlands develops algorithms to study evolving networks.

As the functionality of OSGi-based software frameworks improves and the number and

diversity of dataset and algorithm plugins increases, the capabilities of custom tools will expand.
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